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CAUTION: 
 Read all of these Instructions. 
 Save these Instructions for later use. 
 Follow all Warnings and Instructions marked on the product. 

 
1) Read instructions -- All the safety and operating instructions should be read before the product is operated. 
 
2) Retain instructions -- The safety and operating instructions should be retained for future reference. 
 
3) Heed Warnings -- All warnings on the product and in the operating instructions should be adhered to. 
 
4) Follow instructions -- All operating and use instructions should be followed. 
 
5) Cleaning -- Unplug this product from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a 
damp cloth for cleaning. 
 
6) Attachments -- Do not use attachments not recommended by the product manufacturer as they may cause hazards. 
 
7) Water and Moisture -- Do not use this product near water -- for example, near a bath tub, wash bowl, kitchen sink, or 
laundry tub; in a wet basement; or near a swimming pool; and the like. 
 
8) Accessories -- Do not place this product on an unstable cart, stand, tripod, bracket, or table. The product may fall, causing 
serious injury to a child or adult, and serious damage to the product.  Any mounting of the product should follow the 
manufacturer ﾕ s instructions, and should use a mounting accessory recommended by the manufacturer. 
 
9) Ventilation -- Slots and openings in the cabinet are provided for ventilation and to ensure reliable operation of the product 
and to protect it from overheating, and these openings must not be blocked or covered. The openings should never be 
blocked by placing the product on a bed, sofa, rug, or other similar surface. This product should not be placed in a built-in 
installation such as a bookcase or rack unless proper ventilation is provided or the manufacturer ﾕ s instructions have been 
adhered to. 
 
10) Power Sources -- This product should be operated only from the type of power source indicated on the marking label. If 
you are not sure of the type of power supply to your home, consult your product dealer or local power company. For products 
intended to operate from battery power, or other sources, refer to the operating instructions. 
 
11) Grounding or Polarization -- This product may be equipped with a polarized alternating-current line plug (a plug having 
one blade wider than the other). This plug will fit into the power outlet only one way. This is a safety feature. If you are 
unable to insert the plug fully into the outlet, try reversing the plug. If the plug should still fail to fit, contact your electrician 
to replace your obsolete outlet. Do not defeat the safety purpose of the polarized plug. 
 
12) Power-Cord Protection -- Power-supply cords should be routed so that they are not likely to be walked on or pinched by 
items placed upon or against them, paying particular attention to cords at plugs, convenience receptacles, and the point 
where they exit from the product. 
 
13) Lightning -- For added protection for this product during a lightning storm, or when it is left unattended and unused for 
long periods of time, unplug it from the wall outlet. This will prevent damage to the product due to lightning and power-line 
surges. 
 
14) Overloading -- Do not overload wall outlets, extension cords, or integral convenience receptacles as this can result in risk 
of fire or electric shock. 
 
15) Object and Liquid Entry -- Never push objects of any kind into this product through openings as they may touch 
dangerous voltage points or short-out parts that could result in a fire or electric shock. Never spill liquid of any kind on the 
product. 
 
16) Servicing -- Do not attempt to service this product yourself as opening or removing covers may expose you to dangerous 
voltage or other hazards. Refer all servicing to qualified service personnel. 
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17) Damage Requiring Service -- Unplug this product from the wall outlet and refer servicing to qualified service personnel 
under the following conditions: 
a) when the power-supply cord or plug is damaged. 
b) if liquid has been spilled, or objects have fallen into the product. 
c) if the product has been exposed to rain or water. 
d) if the product does not operate normally by following the operating instructions. Adjust only those controls that are 
covered by the operating instructions as an improper adjustment of other controls may result in damage and will often 
require extensive work by a qualified technician to restore the product to its normal operation. 
e) if the product has been dropped or damaged in any way. 
f) when the product exhibits a distinct change in performance -- this indicates a need for service. 
 
18) Replacement Parts -- When replacement parts are required, be sure the service technician has used replacement parts 
specified by the manufacturer or have the same characteristics as the original part. Unauthorized substitutions may result 
in fire, electric shock, or other hazards. 
 
19) Safety Check -- Upon completion of any service or repairs to this product, ask the service technician to perform safety 
checks to determine that the product is in proper operating condition. 
 
20) Heat -- The product should be situated away from heat sources such as radiators, heat registers, stoves, or other 
products (including amplifiers) that produce heat. 
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FCC Part 15 
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense. 
 
Caution 
Changes or modifications to this equipment not expressly approved by TEAC CORPORATION for compliance 
could void the user's authority to operate this equipment. 

 

For the customers in Europe 
WARNING 
This is a Class A product. In a domestic environment, this product may cause radio interference in which case 
the user may be required to take adequate measures. 
 
 
Pour les utilisateurs en Europe 
AVERTISSEMENT 
Il s'agit d'un produit de Classe A. Dans un environnement domestique, cet appareil peut provoquer des 
interférences radio, dans ce cas l'utilisateur peut être amené à prendre des mesures appropriées. 
 
 
Für Kunden in Europa 
Warnung 
Dies ist eine Einrichtung, welche die Funk-Entstörung nach Klasse A besitzt. Diese Einrichtung kann im 
Wohnbereich Funkstörungen versursachen ; in diesem Fall kann vom Betrieber verlang werden, 
angemessene Maßnahmen durchzuführen und dafür aufzukommen. 

 
DISCLAIMER 
TEAC disclaims all warranty, either expressed or implied, with respect to this product and the accompanying 
written materials.  In no event shall TEAC be liable for any damages whatsoever (including, without 
limitation, damages for loss of business profits, business interruption, loss of business information or other 
loss) arising out of the use of or inability to use this product. 
 

 This product is not an approved medical device. 
 The names of products that appear in this document are registered trademarks of the respective 

holders. 
 Specifications are subject to change without notice.  
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IMPORTANT:  
PLEASE CAREFULLY READ THE LICENSE AGREEMENT HEREIN BEFORE USING THE SOFTWARE. THE RIGHT TO USE 
THE SOFTWARE IS GRANTED ONLY ON THE CONDITION THAT YOU AGREE TO THE LICENSE AGREEMENT. IN CASE 
YOU DO NOT AGREE TO THE LICENSE AGREEMENT, DO NOT INSTALL THE SOFTWARE. IF YOU HAVE ALREADY 
INSTALLED THE SOFTWARE, STOP THE USE AND UNINSTALL THE SOFTWARE. IF YOU DO NOT AGREE TO THE 
LICENSE AGREEMENT, YOU MAY RETURN THE PACKAGE FOR A REFUND. UNAUTHORIZED REPRODUCTION OR 
DISTRIBUTION OF THE SOFTWARE, OR ANY PORTION OF IT, MAY RESULT IN SEVERE CIVIL AND CRIMINAL 
PENALTIES, AND WILL BE PROSECUTED TO THE MAXIMUM EXTENT POSSIBLE UNDER LAW. 

 
This License Agreement with limited warranty is a legal agreement between you (either an individual or a single entity) and 
TEAC  Corporation ("TEAC") for the SOFTWARE, which include computer software and electronic documentation.  
 
1. GRANT OF LICENSE 
TEAC grants to you the right to use the SOFTWARE only in combination with the TEAC recording unit LX Series. 
 
2. COPYRIGHT 
All title and copyrights in and to the SOFTWARE and any copies thereof are owned by TEAC or a supplier to TEAC. The 
SOFTWARE is protected by Japanese copyright laws, international treaty provisions, and all other applicable national laws.  
 
3. RESTRICTIONS 
You may not distribute copies of the SOFTWARE to third parties. 
You may not reverse engineer, decompile, or disassemble the SOFTWARE, except and only to the extent that applicable law 
notwithstanding this limitation expressly permits such activity. 
You may not rent or lease the SOFTWARE. 
You may not reproduce the SOFTWARE except for archival purpose. 
 
4. TERMINATION 
Your rights under this Agreement terminate upon the disposal of all copies of the SOFTWARE, or without prejudice to any 
other rights, TEAC may terminate this Agreement if you fail to comply with the terms and conditions of this Agreement.  In 
such event, you must destroy all copies of the SOFTWARE. 
 
5. LIMITED WARRANTY 
TEAC warrants that the SOFTWARE will be usable for the purpose expressed on TEAC's document when properly installed 
on a computer. TEAC does not warrant that the operation of the SOFTWARE will be uninterrupted or error free, and that the 
SOFTWARE is fit for any particular purpose. 
 
6. NO LIABILITY FOR CONSEQUENTIAL DAMAGES 
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL TEAC BE LIABLE FOR ANY SPECIAL 
INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES 
FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER 
PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF TEAC HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  BECAUSE SOME STATES AND JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION 
MAY NOT APPLY TO YOU. 
 
7. MISCELLANEOUS 
This agreement is governed by the laws of Japan. 
 
Should you have any questions concerning this Agreement, or if you desire to contact TEAC for any reason, please write to 
the address set forth below: 
 
TEAC CORPORATION 
3-7-3 Naka-Cho,Musashino-Shi,Tokyo 
180-8550, Japan 
E-mail: tic_cs@.teac.co.jp 
Phone: + 81-422-52-5014 
Fax: +81-422-52-1990 
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Overview  
The LX series instrumentation data recorders can record and reproduce signals of a maximum 48 kHz 

sampling frequency via 8 channels onto MO (Magneto Optical Disk) or PC card media.  Recorded data on 

the media is stored as PC files.  The maximum input channels are 32 channels by using the selectable 

types of the 8 channels input cards and the optional channel expansion unit.    

You can choose the recording media among the followings: Recording to the internal memory, 3.5 inch 

MO, PC card, and a PC.  

The file format is TEAC's proprietary TAFFmat format. TAFFmat files can be loaded into commercially 

available analysis software. 

From a PC you can use the supplied LX Navi software to set recording conditions such as the input range 

or sampling frequency.  The interface with a PC is hot-pluggable and compatible with IEEE 1394, so after 

setup you can disconnect the LX while the power is still on, and start or stop recording by using control 

buttons on the main unit.  You can also use LX Navi to record or reproduce while connected to a PC.  

You can chose the 100BASE-TX Ethernet interface as alternative.  

 

An optional color LCD remote control unit is available to set recording conditions, to record and reproduce, 

and to monitor by using bar meters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LX-10 or LX-20 

Remote Control Unit 
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Reproduce 
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Features 
 Input/Output Amps 

The LX main unit equips 2 slots and the optional expansion unit provides additional 2 slots for installing the 

input amps and/or the output amps.  The input/output amp provides 8 channels inputs/outputs from the 

below selections. 

DC input amp card: Use to connect voltages and/or to connect signals of external amplifiers.  

     Another DC input amp card for meeting lower sampling frequencies is available. 

PA amp input card: Addition to voltage inputs, use to connect IEPE (Integrated Electronics 

Piezoelectric)type accelerometers.   Another PA amp card for providing A/C 

weighting filter is available.  

ST amp input card:  Use to connect strain gauges and/or gage-type sensors, also voltages.  

Analog output amp card: Use to reproduce analog signals. 

 

 Recording Modes 

You can select either MO drive or PC card drive for data recording on to a removable media. 

Memory recording:  Recording to 64MB (add up to 512 MB as option) internal memory. 

     Stored data can be transferred to the removable media or the PC. 

MO recording:   Recording to 1.3GB MO.   

     Stored data on the MO can be loaded into the PC by using an MO drive mounted. 

PC card recording:  Stored data on the PC card can be loaded into the PC by using the PC card slot.  

PC recording:   ecording directly into the PC.  

 

You can also transfer data to a PC while recording to memory or the media, or automatically save to the 

media after recording to memory. 

 

 Sampling Frequency Series 

Addition to the LX-10/10L providing with 96 kHz sampling frequency series, the LX-20/20L provide with the 

selections of the sampling frequency series of 102.4 kHz, 100 kHz, 96 kHz, or 65.536 kHz and the tachometer 

pulse inputs.  

  

 Interface to PC 

You can select either IEEE1394 (LX-10/20) for higher speed data transfer or 100BASE-TX (LX-10L/20L) for 

LAN configuration on an interface to communicate with a PC.  

 

 Real Time Monitor 

You can monitor the data as formats of wave forms, bar graphs, and digital displays on the PC display while 

recording.  You can reproduce the recorded data on the internal memory or the media.  
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A Variety of Recording Triggers 

Manual: Starts recording manually. 

Level Trigger:   Starts recording by detecting level changes in a specified channel. 

External Trigger:  Starts recording by using an external signal as the trigger. 

Pre-trigger: A pre-trigger can record the data that was read into a 

buffer before a recording-startcondition (based on a level trigger or 

external trigger) was satisfied. 

Post-trigger: Continues to record for a set period even after a recording-stop condition 

(based on a level trigger or external trigger) was satisfied. 

 

Interval operation: Repeatedly starts and stops recording for a specified number of times, during a 

specified period. 

 

 Event Marks 

You can mark data during recording, and search for such event marks when you want to reproduce 

some recorded data. 

 

 Recording and Reproducing Voice Memos 

A microphone amp and a speaker are built in, so you can record and reproduce (listen to) voice 

memos. 
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ch 1 

ch 2 

ch 3 
ch 4 

ch 5 

ch 6 
ch 7 

ch 8 

1/6000 sec

Order of recorded data 

About TAFFmat 
TAFFmat (an acronym for Teac Data Acquisition File Format) is a file format composed of the following: 

 a data file containing A/D (analog to digital) converted data. The file is in binary format with the 

extension dat. 

 a header file containing information such as recording conditions. The file is in text format with the 

extension hdr. 

This document uses the term ID to refer to a collection of data collected from the start of recording on the LX 

series until the recording is stopped or paused.  For each ID, one data file and one header file is recorded.  

A voice memo is recorded as a WAV file with the extension wav. 

The above files share a common file name, to which is appended an ID number.  When a new file name is 

specified, this ID number becomes 1. Each time recording starts, this number is incremented by 1.  

 

 

 

 

 

 

 

 

 

A/D-converted data is recorded as 2-byte integers from -32768 to +32767.  Negative numbers are 

expressed as complements of 2. The byte order is from the lower bytes to the higher bytes.  The data order 

is as follows: first sampling channel order -> second sampling channel order ->...-> last sampling channel 

order.  At the LX series, ADC value +/- 25000 represents +/- 100 % of the input range. 

This document uses the term scan to refer to a collection of data resulting from one sampling. A data file is 

a collection of scan repetitions. 

 

Example: 

Data of 1 scan when the sampling frequency is 6 kHz: 

 

 

 

 

 

 

 

 

 

 

 

 

Standby 
REC 

Start 
FWD 

Pause 
PAUSE 

Resume 
FWD 

Stop 
STOP

Aaaaa001.dat 
Aaaaa001.hdr 

Aaaaa002.dat 
Aaaaa002.hdr 
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Notes on Usage 
 Use of a UPS is Recommended 

We recommend that you use a UPS (Uninterruptible Power Supply) whenever you use an AC adapter.  

This can protect important data during a power stoppage.  If power is turned off while a media is in 

a drive, data recorded on that media might become unreadable.  Use an optional battery unit to 

back up the operation at the power stoppage.  

 

 Use Specified Media Only 

Use 1.3 GB, 3.5 inch MO disks from Fujitsu Ltd.  

Use PC cards checked by TEAC in advance (contact us for information).   

Other media might be unable to record or reproduce correctly.  

 

PC Cards Checked by TEAC for Correct Operations (As of August 2005) 

Sun Disk 

Compact Flash 

Buffalo 

Compact Flash 

Micro Drive 

128MB SDCFB-128-801 64MB RCF-X64MY 340MB DMDM-10340 

256MB SDCFH-256-903 256MB RCF-G256M 1GB DSCM-11000 

SDCFB-512-801 1GB RCF-G1G   
512MB 

SDCFH-512-801 2GB RCF-G2G   

SDCFB-1000-801 

SDCFB-1024-J60 

Lexar Media 

Compact Flash 

Rnesas  PCMCIA TYPEⅡ 

 Flash memory card 1GB 

SDCFH-1024-903 1GB CF1GB-80-380 128MB HB288128A5 

SDCFB-2000-801 2GB CF2GB-40-380 512MB HB28B512A6 
2GB 

SDCFH-2048-J60 1GB HB28B1000A6 I･O Data 

Compact Flash 2GB HB28B2000A8H Hagiwara sys-com 

Compact Flash 256MB CFX-256M   

1GB HPC-CF1GZP 1GB CF40-1G   

 

 Remove Media Before Powering Off the LX 

Remove the media before you power off the LX.  If you power off the LX while data is being written, 

data recorded on that media might become unreadable.  Also, remove the media before moving the 

LX main unit.  Moving the unit while the media is inserted might result in damage, in particular on a 

MO disk.  

 

 Remove Media 

Remove the media only at the STOP state of the REC mode.  

 

 Never Remove Recorded File, Never Rename File/Folder Name of Recorded File By Windows 

Operation 

If you manipulate the recorded files on the media by Windows operation, such as partially removing 

the file, or renaming the file/folder name, the link between the data file and the header file will be 

lost or the writing speed to the media to support the specifications cannot be assured, and then the 

data will become unreadable on the PC when such media is re-inserted in the LX. 

Write-protect an MO disk before inserting it into a PC drive. 
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 Clean Disk and Lens 

Dust might collect on an MO disk or lens after they have been used for a long time.  This dust might cause 

errors. To prevent this problem, clean the MO disk and lens using a cleaning kit (separate purchase). The 

period after which cleaning is required depends on the environment but, as a general rule, clean once every 

three months. 

 To clean an MO disk, use the cleaning kit TZ-381 (separate purchase).  To clean a lens, use the lens 

cleaner 0240470 (separate purchase). 

 For details on how to clean, see the explanation supplied with the cleaning kit. 

 

 Handling PC Card  

To discharge static electricity from your body, touch a metallic surface near you before handling the unit. 

Never touch the media being inserted to the PC card slot while recording and playing back.  

 

 Make Sure to Select FAT16 When Formatting Media by Windows Operation 

The LX file format does not support FAT32, use FAT16 format before using.  

 

 About No MO/PC Card Drive 

The drive is not installed.  Naturally, the functions concerning the recording to the media are disabled. 

 

 About No Output Amp Model 

The output amplifier is not installed.  Naturally, the functions concerning the output amp are disabled.  

However, you can view the reproduced data on a PC. 

 

 Power OFF While Amp Calibration State 

When turning on the power of the LX unit, the unit goes into the calibration of the installed amps 

automatically (Input level LED on each amp are flashing in red), and then goes to the ready state for 

operations (Input level LED turns on green).  Turning the power OFF while the amp calibration state 

initializes the setting parameters.  
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Names and Parts 
Front 
 

 

 

 

 

 

 

 

 

 

 

 

 

1 Drive 

Opening the cover reveals the disk slot. 

 

2 Input level LED 

When the input signal for some channel is larger than +/- 10 % of a set input range, the LED glows 

green.   

When the signal exceeds +/- 115 % of the range, the LED glows red. 

 

3 Input connector 

Inputs the signal to be measured. 

 

4 Power switch 

Pushing the switch up turns on the power.  Pushing the switch down turns off the power.  

 

5 Volume knob 

Adjust the volume for reproducing voice memos. 

 

6 EARPHONE jack 

Connects to an earphone when you are using the earphone to listen to voice memos.   

When an earphone is inserted, sound does not come from the speaker. 

 

7 MEMO IN jack 

Connects to a microphone used for voice memos. 

 

8 USAGE LEDs 
Indicates the usage rate of the recording device.  During recording to memory, these LEDs indicate 
what percentage of the total memory is being used.  During recording to a media, these LEDs 
indicate what percentage of the total media capacity is being used.  During recording to a PC, these 
LEDs indicate what percentage of memory is being used as the buffer for transmitting data.  From 
the left, the LEDs indicate the percentages of 5, 10, 20, 35, 50, 70, 90, and 100%. 
These LEDs also function as a low-voltage alarm, and blink when the power voltage falls to 11 V or 
less. In such a situation, recording or reproduction stops. 

 

1 2 3 

5 

4 

9 8 7 6 10 12 11 
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9 Output connector (When the analog playback amp card is installed into the slot.) 

Outputs the reproduced signal.  Outputs the input signal during recording-standby status or during 

recording.  You can set the output range in 0.1 V steps, from 1 V to 5 V.  

 

10 Output level LED (When the analog playback amp card is installed into the slot.) 

When the output signal for some channel is larger than +/-10% of a set output range, the LED glows green.  

When the signal exceeds +/-115% of the range, the LED glows red. 

 

11 P LOCK button 

Pressing this button for 3 seconds causes the lamp to glow and disables the five buttons on the left: STOP, 

REC, FWD, PAUSE, and EVENT.  To release the lock, again press the button for 3 seconds.  

 

12 Recording/reproduction control buttons 

Buttons used for recording or reproduction. Details are given later. 
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SERIAL NO.

MADE IN JAPAN

Rear 
 

LX-10 IEEE 1394 Version 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The LX-10L LAN version has an interface (at 7) shown below. 

 

 

LX-20L LAN Version 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The LX-20 IEEE 1394 version has an interface (at 7) shown above. 

 

 

 

 

 

1 2 3 4 4 5 6 

8 7 

9 

ＲＸ

ＬＡＮ

SERIAL NO.

MADE IN JAPAN
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1 FG terminal 

Connects the grounding wire. 

 

2 MON OUT connector 

Outputs in analog format, the signal of a channel during recording-standby status, recording, or reproduction.  

You use the supplied LX Navi software to select the channel you want to monitor.  You can set the output 

range in 0.1 V steps, from 1 V to 5 V.  The same filter as for the output amp is applied to this monitor 

output.  

Outputs the generator output signal at the LX-20/20L. 

 

3 EXT TRIGGER IN connector 

Inputs the trigger signal when using an external contact signal as the trigger to start recording.  

 

4 Cooling fan 

Exhaust fans used for cooling the main unit.  Do not cover the outlet vent.  

 

5 BU-80 connector 

Uses to connect the optional battery unit. 

 

6 DC IN connector 

Inputs power in the range from +11 to 30 V. 

 

7 IEEE 1394 connector (LX-10/20 IEEE 1394 version) 

Connects to a PC.  Use a recommended interface card on the PC. 

 

100BASE-TX connector (LX-10L/20L LAN version) 

Connects to a PC.  LED located side of the connector flashes while communications. 

 

8 DIGITAL CONTROL connector 

Use when using a contact signal to control recording or reproduction.  

 

9 PULSE IN A/B connector (LX-20/20L version) 

Connects tachometer pulse inputs. 
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Recording Times 
 Recording to Memory, 8 channels, 64 MB standard memory (when not recording voice memos） 

 

 

 

 

 

 

 

 

 

 

 Recording to MO, 8 channels (when not recording voice memos） 

* This recording time at a 48 kHz sampling frequency is the value when using an MO disk on which nothing is 

recorded after formatting.  

 

 

 

 

 

 

 

 

 

 Recording to PC card, 8 channels, 1 GB PC card is used (when not recording voice memos） 

* This recording time at a 48 kHz sampling frequency is the value when using an MO disk on which nothing is 

recorded after formatting. 

 

 

 

 

 

 

 

 

 

 Media recording time can be calculated as follows (result by approximately times.): 

Recording Time (seconds) = (Media Capacity (Bytes) x 0.9) / [(Number of Analog Input Channels + Number of 

Tachometer Input Channels) x Sampling Frequency (Hz) x 2 + 8000] 

Media Capacity x 0.9: Considering recording overhead of the media and an additional capacity needed for the 

header files, multiply 0.9 (90%) for the used capacity for data files.  

Refer the tables later for a combination of the Sampling Frequency vs. the number of analog input channels can be 

selected in each recording mode. 

Number of tachometer input channels: use "2" in 16 bits mode, "2" for 32 bits/1 channel mode, or "4" for 32 bits/2 

channels mode.  Use "0" instead of 8000 when the memo voice recording turns to OFF.  

Sampling frequency（Value in brackets is the recording 
bandwidth with tolerances of +/-0.5 dB) Recording time 

96 kHz （40 kHz） 40 s 

48 kHz （20 kHz） 80 s 

24 kHz （10 kHz） 160 s 

12 kHz （5 kHz） 320 s 

6 kHz （2.5 kHz） 640 s （approx. 10 min） 

3 kHz （1.25 kHz） 1,280 s （approx. 21 min） 

1.5 kHz （625 Hz） 2,560 s （approx. 42 min） 

Sampling frequency（Value in brackets is the recording 
bandwidth with tolerances of +/-0.5 dB) Recording time 

48 kHz （20 kHz） 1,600 s （approx. 26 min） *

24 kHz （10 kHz） 3,200 s （approx. 53 min） 

12 kHz （5 kHz） 6,400 s （approx. 106 min） 

6 kHz （2.5 kHz） 12,800 s （approx 213 min）

3 kHz （1.25 kHz） 25,600 s （approx. 7 h） 

1.5 kHz （625 Hz） 51,200 s （approx. 14 h） 

Sampling frequency（Value in brackets is the recording 
bandwidth with tolerances of +/-0.5 dB) Recording time 

48 kHz （20 kHz） 1,230 s （approx. 20 min） *

24 kHz （10 kHz） 2,470 s （approx. 41 min） 

12 kHz （5 kHz） 4,940 s （approx. 82 min） 

6 kHz （2.5 kHz） 9,890 s （approx. 164 min） 

3 kHz （1.25 kHz） 19,790 s （approx. 329 m） 

1.5 kHz （625 Hz） 39,360 sec （approx. 11 h） 
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102.4 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*102.4 42 4 2 2 N/A
*51.2 21 8 4 4 4
25.6 10 16 8 8 8
12.8 5 32 24 24 24
5.12 2 32 32 32 32
2.56 1 32 32 32 32
1.28 0.53 32 32 32 32

100 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*100 41 4 2 2 N/A
*50 20 8 4 4 4
20 8 16 8 8 8
10 4.1 32 24 24 24
5 2 32 32 32 32
2 0.8 32 32 32 32
1 0.4 32 32 32 32

96 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*96 40 4 2 2 N/A
*48 20 8 4 4 4
24 10 16 8 8 8
12 5 32 24 24 24
6 2.5 32 32 32 32
3 1.25 32 32 32 32

1.5 0.625 32 32 32 32

65.536 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*65.536 27 4 2 2 N/A
*32.768 13 8 4 4 4
16.384 6 16 8 8 8
8.192 3 32 24 24 24
4.096 1.7 32 32 32 32
2.048 0.8 32 32 32 32
1.024 0.4 32 32 32 32

Max. number of analog input channels based on the tachometer input setting 

Max. number of analog input channels based on the tachometer input setting 

Max. number of analog input channels based on the tachometer input setting 

Max. number of analog input channels based on the tachometer input setting 

Sampling Frequency and Number of Channels 
A combination of the sampling frequency vs. the number of analog input channels is varied depending on the 

selected recording mode, such as, the type of the recording media and the number of tachometer input 

channels.  

 

Recording Condition 1 

Recording Mode: Media recording to MO or PC card, while transferring data to PC 

Memo Voice Recording: ON or OFF 

Interface to PC: IEEE1394 or Ethernet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remarks:  Cannot select the moving average other than 1 (one) at the Sampling Frequency settings shown 

with *(asterisk). 
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102.4 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*102.4 42 8 4 4 N/A
*51.2 21 16 8 8 8
25.6 10 32 24 24 24
12.8 5 32 32 32 32
5.12 2 32 32 32 32
2.56 1 32 32 32 32
1.28 0.53 32 32 32 32

100 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*100 41 8 4 4 N/A
*50 20 16 8 8 8
20 8 32 24 24 24
10 4.1 32 32 32 32
5 2 32 32 32 32
2 0.8 32 32 32 32
1 0.4 32 32 32 32

96 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*96 40 8 4 4 N/A
*48 20 16 8 8 8
24 10 32 24 24 24
12 5 32 32 32 32
6 2.5 32 32 32 32
3 1.25 32 32 32 32

1.5 0.625 32 32 32 32

65.536 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*65.536 27 8 4 4 N/A
*32.768 13 16 8 8 8
16.384 6 32 24 24 24
8.192 3 32 32 32 32
4.096 1.7 32 32 32 32
2.048 0.8 32 32 32 32
1.024 0.4 32 32 32 32

Max. number of analog input channels based on the tachometer input setting 

Max. number of analog input channels based on the tachometer input setting 

Max. number of analog input channels based on the tachometer input setting 

Max. number of analog input channels based on the tachometer input setting 

Recording Condition 2 

Recording Mode: Memory recording 

Memo Voice Recording: ON or OFF 

Interface to PC: IEEE1394 or Ethernet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remarks:  Cannot select the moving average other than 1 (one) at the Sampling Frequency settings 

shown with *(asterisk). 
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102.4 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*102.4 42 8 4 4 N/A
*51.2 21 16 8 8 8
25.6 10 32 24 24 24
12.8 5 32 32 32 32
5.12 2 32 32 32 32
2.56 1 32 32 32 32
1.28 0.53 32 32 32 32

100 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*100 41 8 4 4 N/A
*50 20 16 8 8 8
20 8 32 24 24 24
10 4.1 32 32 32 32
5 2 32 32 32 32
2 0.8 32 32 32 32
1 0.4 32 32 32 32

96 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*96 40 8 4 4 N/A
*48 20 16 8 8 8
24 10 32 24 24 24
12 5 32 32 32 32
6 2.5 32 32 32 32
3 1.25 32 32 32 32

1.5 0.625 32 32 32 32

65.536 kHz Series
Sampling Frequency (kHz)  Bandwidth (kHz) No 16bits 2ch 32bits 1ch 32bits 2ch

*65.536 27 8 4 4 N/A
*32.768 13 16 8 8 8
16.384 6 32 24 24 24
8.192 3 32 32 32 32
4.096 1.7 32 32 32 32
2.048 0.8 32 32 32 32
1.024 0.4 32 32 32 32

Max. number of analog input channels based on the tachometer input setting 

Max. number of analog input channels based on the tachometer input setting 

Max. number of analog input channels based on the tachometer input setting 

Max. number of analog input channels based on the tachometer input setting 

Recording Condition 3 

Recording Mode: PC direct recording 

Memo Voice Recording: ON or OFF 

Interface to PC: IEEE1394 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remarks:  Cannot select the moving average other than 1 (one) at the Sampling Frequency settings shown 

with *(asterisk). 
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41

ＲＸ

ＬＡＮ

SERIAL NO.

MADE IN JAPAN

Connections 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
When the DC power voltage falls to +11V or less, the USAGE LEDs flash and recording and reproduction 

stops. 

If you are recording to memory, quickly copy the data to a media or to a PC.  

 

Connect to PC 100BASE-TX Ethernet 
interface (LX-10L/20L) 

Monitor output, 
Oscilloscope, etc. 

External trigger input, Contact signal
DC power*   
(+11 to 30 V) 
Or use the specified 
AC adaptor. 

Optional 
Battery unit  
BU-80 

Connect to PC IEEE 1394 interface 
(Either is available. 
Use TEAC recommended IEEE 1394 
interface card for PC.) (LX-10/20) 

Tachometer pulse inputs(LX-20/20L)

Remote control unit 
Cannot connect with PC at a time. 

Input signal

Oscilloscope, etc.
Supplied  
Microphone 
(when recording 
voice memos.) 

Supplied earphone 
(when using an earphone 
to listen to voice memos) 
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Notes on Connections 
 Attaching Ferrite Core on IEEE 1394 Interface cable (LX-10/20 IEEE 1394 version) 

To reduce the radio noise, attach the supplied ferrite cores on both ends of the IEEE 1394 cable.  

 

 

 

 

 

 

 

 

 

 

 Only PC to IEEE 1394 Connector (LX-10/20 IEEE 1394 version) 

Do not connect other devices than the PC to the IEEE 1394 connector. If any other devices are 

daisy-chained, the specified performance may not be achieved.  

 

 Grounding 

To prevent noise, establish a common ground for the LX and all the measuring instruments connected to 

it.  

 

PC System Requirements 
We recommend use of a PC that satisfies the following requirements: 

OS: Windows XP / Windows 2000 / Windows 98SE / Windows Me  

CPU: Pentium III 600 MHz or faster 

Screen Resolution: 800×600 dpi or better 

Memory: 128 MB or more (256 MB or more for Windows XP/2000) 

Free space on hard disk: 2 GB or more 

CD-ROM drive: Present (for the program installation) 

LX-10/20 IEEE 1394 version use the specified IEEE 1394 interface card: 

For a note PC (PC card model): From RATOC Systems, Inc.: CBFW3 

For a desktop PC (PCI bus): From RATOC Systems, Inc.: PCIFW3  

LX-10L/20L(LAN 100BASE-TX version, use your PC on-board 100BASE-TX interface 

 

 Use the IEEE 1394 interface card specified above.  Other interface cards might not operate correctly.  

Please contact us for availability. When installing and setting up the interface card, read the 

documentation supplied with the card and set up the card in accordance with that documentation and this 

manual. 

..Use the on-board type 100BASE-TX interface of your PC, do not use the PC card type interface. 

 File sizes and the total number of files may be limited depending on the operation systems. 
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Installing LX-10/20 IEEE 1394 Version 
Overview of the LX-10/20 IEEE 1394 version installation is explained below.  

Follow the installation procedures explained later on each operation system.  

1. Attach the interface card to your PC.  

2. Install the OHCI driver.  

3. Install the LX Series device driver.  

4. Install the LX Navi. 
 
 
Installing Interface Card 
Attach the PC card to your note PC 

Insert the IEEE 1394 interface card CBFW3 to your PC card slot met the CardBus specification. 

Check with your PC manual on the PC card slot information. 

 You may not insert the IEEE 1394 interface card with other types of the PC card at a time. 

 You may not install it to the upper slot. 

 Be careful to insert it to your PC.  The interface card or your PC may be damaged, if you enforce to 

insert it.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Attach the PCI card to your desktop PC 

Insert the PCI type interface card PCIFW3 to the PCI slot of your desktop PC. 

Check with your PC manual on the PCI slot information. 

 Replace a standard bracket to the supplied low profile one when installing the PCIFW3.  

 Be careful to insert it to your PC.  The interface card or your PC may be damaged, if you enforce to 

insert it. 
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Installing OHCI Driver 
For Windows 2000/XP 

The following screen examples are for Windows 2000.  Follow the same procedures for Windows XP.  
1. Insert the CBFW3 to the CardBus PC card slot, or insert the PCIFW3, then turning on your PC.  The 

standard Windows driver will be automatically installed.  Follow the below procedures to confirm the driver 

has been installed correctly.  
 
2. Double click [Control Panel] from [My Computer］. 

 

Double click ［System］ to open the dialog box. 

 
3.Click ［Hardware］ tab, and then click ［Device Manager(D)］. 

 

4. Double click ［1394Bus Host Controller］, and confirm “Texas Instruments OHCI Compliant IEEE 1394 Host 

Controller” is added to indicate the driver software has been correctly installed.  

Now the OHCI driver installation has been completed, next proceed to the LX Series device driver installation. 
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For Windows 98SE 

1. Insert the CBFW3 to the CardBus PC card slot, or insert the PCIFW3, then turning on your PC.  You will 

see the “Update Device Driver Wizard” dialog box.  

 

Click [Next]. 

 
2.Click “Search for a better driver than the one your device is using now. (Recommended)”, then click 

[Next].  

 
3.Remove all checks of the selection boxes, then click [Next]. 
 

4.Click “Updated driver (Recommended)”, then click [Next]. 

 

5.Click ［Next］. 

 

6.Click ［Finish］ to complete the driver software installation. 

 
You can confirm that driver has been installed correctly as follows: 

Double click [Control Panel] from [My Computer］ to open the dialog box. 

 

Double click ［System］. 

 

Click [Device Manager］, then double click ［1394 Bus Controller］.  Confirm “Texas Instruments OHCI 

Compliant IEEE 1394 Host Controller” is added to indicate the driver software has been correctly installed.  

Download the 1394 Storage Supplement Program 

From the Microsoft site, download the 1394 Storage Supplement program.  

1. From the Windows Start menu, click Windows Update. 

 

After the Microsoft site is displayed, click PRODUCT UPDATES on the left.  

 

2.Select “Windows 98 Second Edition 1394 Storage Supplement”, and download it.  

(For details, click Read this first.)  

 

Now the OHCI driver installation has been completed, next proceed to the LX Series device driver 

installation 
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For Windows Me 

1. Insert the CBFW3 to the CardBus PC card slot, or insert the PCIFW3, then turning on your PC.  You will see 

the “Update Device Driver Wizard” dialog box.  

 

Click ［Next］. 

 
2. Clikc ［Finish］. 

 
3. Now you complete the driver software installation. 

 

You can confirm that driver has been installed correctly as follows: 

 

Double click [Control Panel] from [My Computer］ to open the dialog.  Then double click ［System］. 

 

Click [Device Manager］, then double click ［1394 Bus Controller］.  Confirm “Texas Instruments OHCI 

Compliant IEEE 1394 Host Controller” is added to indicate the driver software has been correctly installed.  

 

Now the OHCI driver installation has been completed, next proceed to the LX Series device driver installation 
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Installing LX Series Device Driver 
For Windows 2000/XP 

The following screen examples are for Windows 2000.  Follow the same procedures for Windows XP. 

1. When the LX-10/20 is first connected to the PC, the following dialog box is displayed. 
 
 
 
 
 
 
 
 
 
 
 
Click ［Next］. 

 
2. 
 
 
 
 
 
 
 
 
 
 
 
In the dialog box, click “Search for a suitable driver for my device (recommended)” and then click ［Next］. 

 
3. 
 
 
 
 
 
 
 
 
 
 
 
Insert the supplied CD-ROM, select “Specify a location”, and then click ［Next］. 
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4. 
 
 
 
 
 
 
 
Specify the driver folder of the inserted CD-ROM, and click ［OK］. 

 
5. 
 
 
 
 
 
 
 
 
 
 
 
Click ［Next］. 

 
6. 
 
 
 
 
 
 
 
 
 
 
 
In the dialog box, click ［Finish］.  This completes installation of the device driver. 
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For Windows 98SE 

1. When the LX-10/20 is first connected to the PC, the following dialog box is displayed.  

(If not displayed, proceed to the later page.) 

 
 
 
 
 
 
 
 
 
 
Click [Next]. 

 
2. 
 
 
 
 
 
 
 
 
 
 
In the dialog box, click “Search for the best driver for your device (Recommended)” and then click ［Next］. 

 
3. 
 
 
 
 
 
 
 
 
 
 
Insert the supplied CD-ROM and select “Specify a location”.  Specify the driver folder of the inserted 

CD-ROM, and click ［Next］. 
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4. 
 
 
 
 
 
 
 
 
 
 
Click ［Next］. 

 
5. 
 
 
 
 
 
 
 
 
 
 
In the dialog box, click ［Finish］.  This completes installation of the device driver. 

 

 
If the Add New Hardware Wizard dialog box is not displayed when the LX-10/20 is first connected to the PC, 
install the driver following the steps below:  
1. From the Windows Start menu choose Settings, Control Panel, [System], and then click [Device Manager] 

tab. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select “TEAC Corporation Recording Unit LX-10” and click [Properties].  
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2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click [Reinstall Driver].  

 
3. 
 
 
 
 
 
 
 
 
 
 
Click ［Next］. 

 
4. 
 
 
 
 
 
 
 
 
 
 
Click “Search for a better driver than the one your device is using now. (Recommended)” and then click 

[Next].  
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5. 
 
 
 
 
 
 
 
 
 
 
Insert the supplied CD-ROM and select “Specify a location”.  Specify the Driver folder of the inserted CD-ROM, 

and click [Next].  

 
6. 
 
 
 
 
 
 
 
 
 
 
Click ［Next］. 

 
7. 
 
 
 
 
 
 
 
 
 
 
In the dialog box, click [Finish].  This completes installation of the device driver. 
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For Windows Me 

1. When the LX-10/20 is first connected to the PC, the following dialog box is displayed. 

 
 
 
 
 
 
 
 
 
 
 
Insert the supplied CD-ROM, and select “Automatic search for a better driver (Recommended)”.  Then click 

[Next].  

 
2. 
 
 
 
 
 
 
 
 
 
 
 
In the dialog box, click [Finish].  This completes installation of the device driver.  
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Installing LX Navi 
To install the supplied LX Navi software: 

1. Execute “Setup.exe”, which is in the supplied CD-ROM. 

 
2. Follow the displayed instructions and proceed with setup.  
 
 
 
 
 
 
 
 
 
Click IEEE1394 at the dialog box to be appeared in the middle of installation when using the LX-10/20 IEEE 

1394 version, then click OK. 

 
3. After installation, restart the PC. 
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Installing LX-10L/20L LAN Version 
To install the LX-10L/20L LAN version: 

1. Install LX Navi. 
2. Set the IP address of the PC to be connected and the LX-10L/20L. 

 

 Use an on-board type 100BASE-TX LAN interface of your PC. 

 If your PC does not have a LAN interface, use the following LAN cards:  

CBET100-CL from I-O DATA 

FNW-3603-TX from PLANEX COMMUNICATIONS 

Transmission rate: 10 M, full duplex (fixed) 

One-to-one connection with LX-10L/20L using a cross cable 

 
 
Installing LX Navi 
To install the supplied LX Navi software: 

1. Execute “Setup.exe”, which is in the supplied CD-ROM. 

 

2. Follow the displayed instructions and proceed with setup. 

 
 
 
 
 
 
 
 
 
Click Ethernet at the dialog box to be appeared in the middle of installation when using the LX-10L/20L 

LAN version, then click OK. 

 
3. After installation, restart the PC. 
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About IP Address Settings 
Consult your network administrator when connecting the LX-10L/20L to your network per the following 

information. 

It is required the basic knowledge about Windows network system to set the network connection parameters.  

 

 At shipping time, the LX-10L/20L has the factory settings shown below.  Modify the settings (such as the 

IP address) as necessary. 

IP address: 192.168.0.10 

Subnet mask: 255.255.255.0 

Gateway: 0.0.0.0 

DHCP client: DISABLE 

 

 To communicate at 100 Mbps, all devices that exist in the path from the LX-10L/20L to the controller PC 

must support 100 Mbps. Use a cable that is Category 5 or better.  To ensure communications quality, we 

recommend that you use STP cables and a switching hub that supports STP cables.  

 

 Depending on the network environment being used, it is possible you will encounter delays in data 

transmission or congestion processing.  In such a case, try the following to improve the situation: 

1) If a repeater hub is being used, change to a switching hub instead. 

2) As much as possible, reduce the number of broadcast packets. 

3) As much as possible, use a communications path that does not pass through a router.  

 

 However, in a situation such as when the LX-10L/20L is in a remote location and communications are 

constrained by low-speed paths, use the LX-10L/20L with a reduced sampling rate.  

 

 The LX-10L/20L Ethernet interface carries out TCP connection continuous communications; however, if a 

packet from the other party does not arrive within 180 seconds, a timeout occurs and the other party is 

automatically disconnected.  So in the event that a normal termination was not possible because of some 

problem such as a PC hangup or disconnected cable, wait 180 seconds and then try reconnecting.  

 

 If the PC enters the standby status while LX Navi is being used, communications will cease, and a timeout 

will cause a disconnection.  If you are using the PC for a long time, make sure the system standby setting 

in the Windows power options is not selected.  

 

 With the LX-10L/20L Ethernet interface, the LX-10L/20L can be operated as a DHCP (Dynamic Host 

Configuration Protocol) client, but if an IP address cannot be obtained within 30 seconds after startup, the 

LX-10L/20L starts usual operations with a fixed IP address.   

 

 If you set a firewall on your PC or install an virus check software, you may not connect the LX.  Check the 

security level of the program on your PC. 

 

For other settings, such as IP address parameter settings and network usage, consult your network 

administrator before using the LX-10L/20L.  

 



Starting Program 

2-18 

Starting Program 
After installing the drivers and LX Navi and connecting the PC and the LX, start LX Navi.  

 

 Do not run LX Navi together with application software that uses a lot of memory. 

 

To start LX Navi: 

1. On the LX-10 main unit, push up the power switch to |. 

When power is turned on, the input amp is automatically calibrated.  During calibration, the input amp LED 

will blink. When calibration ends the LED will turn off. 

 

2. Start LX Navi. 

After LX Navi starts, if you power off the LX-10/20 main unit or remove the IEEE 1394 cable, LX Navi will 

display an error message and terminate.  In such a case, if you turn the power back on or reconnect the 

cable, and then restart LX Navi, the LX-10/20 can again be recognized. 

In case of the LX-10L/20L, if you power off the LX-10L/20L main unit or remove the LAN cable, not only 

the communications fail, but also the congestion processing is caused to the network.  Make sure to close 

LX Navi first to detach the LX-10L/20L from the network.  Do not power off the LX-10L/20L before closing 

LX Navi.  

 

 If it is taking an excessively long time for the LED to turn off. 

After you power on the main unit, if it takes an excessively long time for the input amp LED to turn off, 

the amp might not have been recognized.  In such a case, turn the power on again.  

 

 Do not put the PC into sleep mode. 

Set your PC's sleep mode to OFF.  If the PC goes into sleep mode, an error occurs on the LX Navi.  Note 

that some notebook PCs automatically go into sleep mode just by folding the display.  

 

For LX-10/20 IEEE 1394 version 

 
 
 
 
 
 
 
 
 
 
 
 
 
Check the box at the serial field of the LX Network dialog box by confirming the correct serial number 

is displayed, and then click OK. In addition, a previously used serial number will automatically contain a 

check in the box. 

 

 

 



Starting Program 

2-19 

 

For LX-10L/20L LAN version 

The following dialog box is displayed when LX Navi starts. 

 

 

 

 

 

 

 

 

 

 

 

 

Check the box at the serial field LX Network dialog box by confirming the white-out box is appeared and 

the correct serial number is displayed, and then click OK. In addition, a previously used serial number will 

automatically contain a check in the box. 

 

If the white-out box is not appeared, follow the next pages for a proper set up.  

 

The upper part lists the LXs that exist in the same segment.  If you click where IP address or name is 

displayed in the list area, the LX Property dialog box appears. In this dialog box, you specify settings such 

as the IP address parameters and the recorder name (Name).  Enter the address parameters that match the 

network environment you are using.  For Name, you can use any string up to 32 characters.  This name is  

displayed in the list at startup, so use a name that identifies the particular LX-10L/20L from any others. 

 

 

 

 

 

 

 

 

 

 

 

 

Click the OK button to apply the IP address parameters for the LX-10L/20L.  It is not necessary to restart the 

LX-10L/20L, but it takes a few seconds for the changed settings to actually take effect so wait for at least 5 

seconds and then connect to the LX-10L/20L.  If the list is not updated or the entry disappears from the list, 

click the Update List button to update the list. 
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Note that if the LX-10L/20L is already being used from another PC, a red check mark is displayed and USE 

is displayed in the status field.  In such a case, you cannot connect to that LX-10L/20L. 

 

 
 
 
 
 
 
 
 
 
 
 
 
If a TCP connection is not possible because of a problem such as an incorrect IP address for the same 

segment, a grey check box is displayed along with IP ERR is the status field.  In such a case, specify an 

appropriate IP address or check the IP address settings (Subnet mask, Gateway, etc.) between the PC and 

the LX-10L/20L, and then connect to the LX-10L/20L. 

 

 

 

 

 

 

 

 

 

 

 

 

When connecting to an LX-10L/20L that exists in a different segment (and, for example, going beyond the 

router), select the IP Direct check box, enter the address of the device to be connected, and then click 

OK. 
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When multiple LX-10L/20Ls are found in the same segment, the dialog box appears as shown below.  In such 

a case, select the check box of the LX-10L/20L to be connected, and click the OK button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

On the real time PC recording of the LX-10L/20L, the speed of the data transfer cannot catch up to the 

recording throughput per a time unit.  In this scenario, the recording will stop automatically when the memory 

buffer of the LX is getting full with the un-transferred data.  It is caused by depending on the PC specifications 

and the networktraffic; however, the following sampling setting is not applicable for the real time PC 

recording.  

Sampling Frequency 96 kHz x  8 ch （Memo voice ON/OFF） 

 

If multiple LX units by using LX Navi are connected to a single PC (regardless with IEEE 1394 or LAN), the wave 

form settings and the data folder settings of each LX may cause conflict to others because the LX Navi shares 

the common save area.  Use each LX for each PC. 

The Main Window will be displayed by starting LX Navi when the connection completes. 

See Section 3 Introduction to LX Navi. 
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Starting Navi directly without the LX Network dialog box displayed 
 

Specify the “/D” option when starting LxNavi with reference to the following methods. If previously used 

serial numbers of LX are connected to I/F, Navi will launch directly without the LX Network dialog box 

displayed. The LX Network dialog box is displayed if previously used serial numbers of LX are connected 

to I/F. 

 

(Example 1) Open the LxNavi shortcut properties and specify “/D” where Target is displayed.  

 

 Target    "C:¥Program Files¥TEAC¥LX Navi¥LxNavi.exe" /D 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Example 2) from the start menu click Run…, specify LxNavi/exe and enter option “/D” after that, and 

click OK.  

 

Target   "C: ¥Program Files¥TEAC¥LX Navi¥LxNavi.exe" /D 
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Inserting and Ejecting Media 
 

Inserting Media 
 Insert or eject the media when the LX is at the STOP state of the REC mode. 

 To discharge static electricity from your body, touch a metallic surface near you before handling the unit.   

Never touch the PC card being inserted to the PC card slot while recording and playing back.  

 

1. Power on the LX main unit.  Wait until the STOP lamp glows before proceeding to the next step. 

2. Open the cover of the drive. 

3. Insert the media, with the label facing up, into the slot. 
4. Close the cover of the drive. 

 
For MO drive 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Use Specified MO Disks Only 

MO 

Use 1.3 GB, 3.5 inch MO disks from Fujitsu Ltd.  Other MO disks might be unable to record or reproduce 

correctly.  

PC Card 

To ensure the recording performance of the main unit, use the PC cards specified in section 1-6 ‘Verified PC 

cards’.  

Eject button



Inserting and Ejecting Media 

2-24 

 
 Formatting Media 

MO 

A specified MO disk is not formatted.  If you insert an unformatted MO disk into the drive, the MO disk will 

not be recognized as a recording device, and recording will not be possible.  To format an MO disk, from 

the File menu of LX Navi choose Format.  Type the volume name and then click Format.  

 

 

 

 

 

 

PC Card 

From the File menu of LX Navi choose Format.  Or format the PC card to FAT16 by PC. 

The LX cannot use the PC card formatted by FAT32, re-format by FAT16 to use such card.  

 

Ejecting Media 
 Turn off the power after you eject the media 

Remove the media before powering off the LX.  If the power is turned off during writing, data recorded on 

the media might become unreadable.  Also, eject the media before moving the LX main unit.  Moving the 

unit while the media is inserted might result in damage.  

 Insert or eject the media when the LX is at the STOP state of the REC mode. 

 To discharge static electricity from your body, touch a metallic surface near you before handling the 

unit.   

Never touch the PC card being inserted to the PC card slot while recording and playing back.  

 

1. Open the cover of the drive. 

2. For MO disk, click the       button on the toolbar of LX Navi to eject the MO disk. 

For PC card, push the eject lever of the drive to eject the PC card. 

3. Remove the media. 

4. Close the cover of the drive. 

 

 While LX Navi is running, the Eject button on the MO drive has no effect. 

 You cannot remove the media during recording or reading.  The data will be corrupted. 

 

About Data on Media 
In a PC's drive, the data recorded on a media can be recognized as files in TAFFmat format.  Therefore, the 

files can be read by commercially available analytical software.  However, write-protect an MO disk before 

inserting it into a PC drive.  If the MO disk is not write-protected and you perform a file operation such as 

moving, deleting, or renaming a file or folder, the link between the data file and the header file might be 

lost, and the data might become unreadable on the PC.  Also, the data might be unreadable when such 

media is re-inserted in the LX.  
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Tabs added by the expansion unit. 

About Expansion Unit 
When the expansion unit AU-LXEPIO(for DC amp/Output amp) or AU-LXEPIOP(PA amp/ST amp/Output amp) 

is added, install input/output amps in the following combinations:  

 

16 inputs + 16 outputs 

(From the upper slot to the lower) 

Slot 1: Input amp 

Slot 2: Input amp 

Slot 3: Output amp 

Slot 4: Output amp 

 

32 inputs 

Install input amps into all slots. 

 

 

About Slot Settings 
When the expansion unit is added, tabs are added to the System dialog.  Click the tab and set for each slot. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
About Maximum Sampling Frequency When Using Expansion Unit 
 

Channels Memory Recording Media Recording (MO/PC card) 

2 ch 96 kHz 96 kHz 

4 ch 96 kHz 96 kHz 

8 ch 96 kHz 48 kHz 

16 ch 48 kHz 24 kHz 

32 ch 24 kHz 12 kHz 
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MODEL NO.

TEAC CORPORATIONSERIAL
NO. MADE IN JAPAN

BATTERY UNIT:BU-80

RECORDING UNIT

12-28V ,

TEAC INSTRUMENTS CORP.

3.0-1.5A

LX-10

MADE IN JAPAN

SERIAL NO.

MODEL NO.

TEAC CORPORATIONSERIAL
NO. MADE IN JAPAN

EXPAND I/O BOX FOR PA AMP

AU-LXEPIOP

BATTERY UNIT:BU-80

RECORDING UNIT

12-28V ,

TEAC INSTRUMENTS CORP.

3.0-1.5A

LX-10

MADE IN JAPAN

SERIAL NO.

About Power Supply Connection 
 
LX Main Unit + AU-LXEPIO 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
LX Main Unit + AU-LXEPIOP 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Optional 
battery unit 
BU-80 

DC power Supply  
(+11 to 30 V) 
Or the supplied AC 
adaptor 

When the optional battery unit 
BU-80 is used, connect the DC cable 
of the expansion unit. 

Optional battery 
unit BU-80 

When the optional battery unit 
BU-80 is used, connect the DC 
cable of the expansion unit to the 
BU-80 connector of the main unit.

DC power Supply  
(+11 to 30 V) 
Or the supplied AC 
adaptor 

DC power Supply  
(+11 to 30 V) 
Or the supplied AC 
adaptor 
Needed for both  the 
main unit and the 
expansion unit. 
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Outline of Main Window 
Start LX Navi program, the following main window will be displayed. 

Menu bar Toolbar Status display 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
These enables you to switch between 
the Recording mode(REC) and the 
view mode(VIEW), check the name of 
a recording file, select the name of a 
recording file, select the files to be 
reproduced, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu bar 

New: Select the device on which 
data is to be recorded, and 
specify the file name. 

Open: Select data to be reproduced. 
Copy: Copy data. 
Format: Format a media. 
Exit: Quit the application. 

System: Set operations, recording conditions,
and reproduction conditions. 

Trigger: Set trigger actions. 
Params: Property: Save or load settings. 

Toolbar： Display or hide the toolbar. 
Status Bar： Display or hide the status bar.
Bar： Display or hide bar meters. 
Digit： Display or hide digital values. 
Hdr： Display or hide header information.

Area for displaying waveforms
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Toolbar 

Status display 

File → New 

File → Open 

File → Copy 

Setup → System

Setup → Trigger 

Setup → Params Property 

Read TEDS information

Auto offset, 
Calibration 

Skip settings

Skip to previous 

Skip to later 

Stop 

Rec standby

Start

Pause 

Event mark 

Eject

Stop the fan 

Listen to data

View → Bar 

View → Digit 

Execute calibration

View → Hdr 

Zero balance

Remaining fan-stop time 

Displays the mode: RECORD for 
recording or VIEW for reproduction.

Current date and time 
In View mode: date and time of recording Number of event marks 

Operating status 
STOP: Idle status 
RECSTANDBY: Recording-standby status 
REC: Now recording 
PLAY: Now reproducing 
PAUSE: Reproduction is paused 

Elapsed time 
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Overview of Steps in Recording and Reproduction 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mode becomes the view mode. 

Start LX Navi 

Recording 
File, New 

Reproducing 
File, Open 

Specify the recording device and file name. 

Mode becomes the recording mode. 

Operations to control recording 

After finishing recording to memory, store on media or PC. 

Select the file to be reproduced. 

When the memory 
recording is selected 

Operations to control reproduction 
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System Settings 
To specify settings fro the LX operations, from the Setup menu choose System. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Sample 
Select the sampling frequency.  Select the sampling frequency series including the sampling frequency to be 

selected at the upper row, then select the sampling frequency within the list shown at the lower row.  They 

are to be limited based on the selected recording media and the tachometer pulse input channels.  See 

“1-13 Sampling Frequency and Number of Channels”.  

 

 

 

 

 

 

 

 

 

 

 

 

LX-10/10L 

You can select the sampling frequency series of 96k-1.5k only at the upper row for the sampling frequency of 96 kHz, 48 

kHz, 24 kHz, 12 kHz, 6 kHz, 3 kHz, or 1.5 kHz at the LX-10/10L.  

LX-20/20L 

You can select the sampling frequency from the followings;  

96k-1.5k for 96 kHz, 48 kHz, 24 kHz, 12 kHz, 6 kHz, 3 kHz, or 1.5 kHz 

100k-1k for 100 kHz, 50 kHz, 20 kHz, 10 kHz, 5 kHz, 2 kHz, or 1 kHz 

102.4k-1.28k for 102.4 kHz, 51.2 kHz, 25.6 kHz, 12.8 kHz, 5.12 kHz, 2.56 kHz, or 1.28 kHz 

65.536k-1.024k for 65.536 kHz, 32.768 kHz, 16.384 kHz, 8.192 kHz, 4.096 kHz, 2.048 kHz, or 1.024 kHz. 

AR-LXDC2 

You can select 1k-1/60 for 1 kHz, 500 Hz, 200 Hz, 100 Hz, 50 Hz, 20 Hz, 10 Hz, 5 Hz, 2 Hz, 1 Hz, 1/2 Hz, 1/5 Hz, 1/10 Hz, 

1/30 Hz, or 1/60 Hz when the low-speed sampling DC amp card is installed.  

Select the sampling frequency. 

Lock the panel. 

Stop the fan during recording. 

Record voice memos. 

Set the clock. 

Settings for the monitor 
output and the generator 
output. 

Number of channels used for 
recording at the slot 1. 

Enable the slot. 

Move among the tabs.
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Memo 
Set to ON when recording or reproducing a voice memo. Voice memo data is recorded as a WAV file separately 

from the data and header files, using 8,000 bytes per second.  Note that this data increases even when the 

microphone is removed from the jack. 

 

 Voice memo is not recorded during the pre-trigger period. In playback, the voice is played back from the 

beginning of data. So, the voice and data are not synchronized.  

 

 

 

 

 

 When recording the voice memo under the (only) PC direct recording, click        or press the PAUSE 

button of the main unit to pause before recording stop.  

Fan 
When you set this to OFF, you can stop the cooling fan on the LX-10 for a period of 10 minutes from the start 

of recording. This is useful for recording noise. If you have already stopped the fan and recorded data, wait for 

about 10 minutes before you again stop the fan and record. 

When you set this to ON, the cooling fan is turned to on.  However, by clicking the fan stop button on the 

toolbar, you can stop the fan while recording.  Click again to restart the fan.  An accumulated time to stop the 

fan within a single recording (from recording start to stop) is 10 minutes.  The remaining time to stop the fan is 

displayed at the status display.  (See 3-3 Outline of Main Window, Toolbar and Status Display.) 

 

Panel 
When you set this to Lock, you can disable the control buttons on the front of the main unit.  

 

Clock 
Use this to adjust the internal clock on the main unit.  The current date and time according to the internal 

clock are displayed here.  

To change the date, click the ▼ button on the right of the date.  A calendar will appear.  In the calendar, click 

the desired date.  To change the time, click the digits you want to change and then either type the desired time 

or click the ▲ or ▼ button on the right of the time to increment or decrement the time value.  After you have 

changed the date or time values, click Set to apply the new settings. 

Click PC to set the date and time of the PC connected.  

 

Slot Use 
Turn on a check box to enable the corresponding slot to be used for recording or reproduction.  For Slot 1, you 

can choose the number of channels to be used for recording from 2, 4, and 8. 

Use the slot tab of the System dialog for the settings of the input and output amps enabled here. 

At the LX-20/20L, turn on Tacho check box to enable the tachometer pulse input channels.  

 

 You cannot use the tachometer pulse input channels and the generator output function at the time. 

 

 

Data reproduction

Voice playback 

Pre-trigger
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Monitor/Generator 
In Signal, select the monitor channel or the type of the generator output signals (only for the LX-20/20L) to 

be output from the MON OUT connector on the rear panel.  If you don't want to monitor any channel, set 

NONE.  

In Range set the output range. You can set the output range in 0.1 V steps, from 1 V to 5 V. 

Click Property to set the output range of the monitor channel or the details of the generator output signal.  

 

 

 

 

 

 

 

 

 

 

 

 

 

In Signal, select the monitor channel or the type of the generator output signals (sine, sweep sine, pulse, 

pink noise, or white noise from the MON OUT connector of the LX-20/20Ls).  

When you select the generator output signal, you can select the following parameters show at the dialog.  

(The parameters can be set are automatically appeared depending on the selection of the output signal.) 

 

Sin/Sweep 
Start Freq: Set the start frequency (Hz) when <sine> or <sweep sine> is selected at Signal. 
Stop Freq: Set the stop sweep frequency (Hz) when <sweep sine> is selected at Signal. 
Rate: Set the sweep rate when <sweep sine> is selected at Signal. 

Pulse 
Pulse Width: Set the pulse width when <pulse> is selected at Signal. 
Pulse Interval: Set the pulse interval when <pulse> is selected at Signal. 

 

Select the output range at Range from 1 V to 5 V at 0.1 V steps.  

 

See Section 6 for the specifications of the generator output.  

 

 You cannot use the tachometer pulse input channels and the generator output function at the time. 

 

 You cannot use the monitor output of the analog signal when recording at the low-speed sampling (1 

kHz to 1/60 Hz).  
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Input Amp Settings 
In the System dialog, click the tab of the slot in which the input amp is installed.  The setting parameters are 

valid depending on the type of the amps installed.  

 

DC Amp AR-LXDC/DC2 
<DC-8> is shown at the Slot tab. 

The AR-LXDC2 is a DC input amp equipped the low-speed samplings (1 kHz to 1/60 Hz) addition to the functions 

that the AR-LXDC supports. 

See Section 6 for the specifications. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Range Settings 

You can select from +/- 0.5, 1, 2, 5, 10, 20, or 50 V.  A range of +/- 131% of the selected range can be 

obtained for A/D (analog to digital) conversion value; however, the input margin level is approximately +/- 

120%.  Input the signal, then click  button on the right and specify the setting while checking the level.  

 

Auto 
When you input the signal and click Auto, the optimum input range is set automatically.  

 

Same Setting 
Check to apply the same settings to the channels later than the channel changed. 
 

 You cannot use the analog output signal of the monitor output and/or the analog output amp when 

recording at the low-speed sampling (1 kHz to 1/60 Hz).  

 

 You can reproduce the data recorded at the low-speed sampling from the analog output amp by changing 

the reproduce sampling speed at 1.5 kHz or higher.  

 

 

Select the input range. 

Check the input level.

Check the input levels of all channels.
Stop checking the input levels.

For the auto range setting.
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PA Amp AR-LXPA1/PA3 
Two types of the PA amps for a voltage output accelerometer input are available for the LX series.  

<PA-8> is shown at the Slot tab for the AR-LXPA1. 

<PA3-8> is shown at the Slot tab for the AR-LXPA3. 

The AR-LXPA3 is an amp equipped +/- 50 V input range and A and C weighting filters addition to the 

functions that the AR-LXDC supports. 

See Section 6 for the specifications. 

 

Cautions on Using PA Amp 
 

 Calibration 

It is suggested to use 0.01 V range of the LX PA amp after turning on the power for 10 minutes or more, and 

then executing manual calibration.   

In order to execute the manual calibration for precisely measurement, click       button on the toolbar 

of the LX Navi.  Also it is recommended to use the balanced input mode for precisely measurement. 

 

 Input Connection and Grounding 

When using many sensors or circuit signals of operations powered by a battery: 

Input Mode: Balanced (Bal) mode 

 

Whenever possible, connect the LX frame ground (FG) to ground. 

 

 

 

 

 

 

 

 

 

 

 

When using circuit signals (AC, ICP, DC) of operations powered by an AC power source: 

Input Mode: Balanced (Bal) mode 

Always connect the frame ground (FG) of the input signal source and the LX frame ground (FG) to ground.  

 

 

 

 

 

 

 

 

 

 

 

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit 

AR-LXPA

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit

AR-LXPA

GND 
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When using circuit signals (DC) of operations powered by an AC power source: 

Input Mode: Unbalanced (Unbal) mode 

If the frame ground (FG) of the input signal source is connected to ground, do not connect the LX frame ground 

(FG) to ground. 

 

 

 

 

 

 

 

 

 

 

 

When using circuit signals (DC) of operations powered by an AC power source: 

Input Mode: Unbalanced (Unbal) mode 

If there is no frame ground (FG) of the input signal source, connect the LX-10 frame ground (FG) to ground. 

 

 

 

 

 

 

 

 

 

 

 

 

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit

AR-LXPA

AR-LXPA

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit
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AR-LXPA1 Setting Dialog 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AR-LXPA2 Setting Dialog 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Only combination of DC/OFF/FLAT selections is applicable at Bal/Unbal: Unbal.  

 

 At the AR-LXPA2 amp, you can select between 28 V DC and 24 V DC on the sensor power supply at the 

internal dip switch.  The factory default is 28 V DC.  Contact TEAC for 24 V DC setting.  

Select the weighting filter. 
A: A filter 
C: C filter 
FLAT: Flat 

Select HPF (High Pass Filter). 
OFF: No 
10Hz: 10 Hz 
20Hz: 20 Hz 

Select the input range (0.01 V, 0.0316 V, 0.1 V, 0.316 V, 
1 V, 3.16 V, 10 V) 

Select the coupling mode. 
AC: AC coupling 
DC: DC coupling 

Select turning ON or OFF of the power supply to 
the sensor connected. 
OFF: No supply 
4mA: Supply 4 mA constant current 

Select Balanced or Unbalanced input. 
Bal: Balanced 
Unbal: Unbalanced 
Automatically set to DC coupling for all 8 
channels when the balanced input is 
selected. 
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ST Amp AR-LXST1 
<ST1-8> is shown at the Slot tab for the AR-LXST1. 

The AR-LXST1 is an input amp applied for strain gauges and strain gauge type sensors and DC inputs. 

See Section 6 for the specifications. 

 

Cautions on Using ST Amp 
 

 Calibration 

It is suggested to use the LX ST amp after turning on the power for 5 minutes or more, and then executing 

manual calibration.   

In order to execute the manual calibration for precisely measurement, click       button on the toolbar of 

the LX Navi.  Also it is recommended to use the balanced input mode for precisely measurement. 

 

 Input Connection and Grounding 

When using sensors: 

Input Mode: Balanced (Bal) mode 

 

Whenever possible, connect the LX frame ground (FG) to ground. 

 

 

 

 

 

 

 

 

 

 

 

When using circuit signals (DC) of operations powered by an AC power source: 

Input Mode: Balanced (Bal) mode 

Always connect the frame ground (FG) of the input signal source and the LX frame ground (FG) to ground.  

 

 

 

 

 

 

 

 

 

 

 

 

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit 

AR-LXST

GND 

FG 

Vs 

- 

+ +

- 

LX Main Unit

AR-LXST

GND 
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AR-LXST1 Setting Dialog 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the input range. 
Click uST to turn the button at the right bottom to mV/V. 

Change the input range display 
between uST and mV/V. 

Change the bridge voltage. 
Turn to OFF to set the DC input range. 

Set the low pass filter. 
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Sensitivity Setting Using TEDS Functions 
When a transducer/sensor conforms to the IEEE Std 1451 A SMART TRANSDUCER INTERFACE is connected to 

the AR-LXPA1/AR-LXPA2, the LX can read its Transducer Electronic Data Sheet (TEDS) information, then can 

display the information and set the acquired sensitivity coefficient automatically to the channel that the 

transducer is connected.  

 

 If the information of the transducer is not complied with the IEEE TEDS standard template, the LX cannot 

read and display the information correctly.  

 

1. Click the toolbar icon         in the main window. 

 

 

 

 

 

 

 

 

 

 

 

2. The TEDS dialog is displayed.  If you turn ON the power of the LX after connecting the TEDS transducers, 

the TEDS information is automatically loaded at the initial calibration stage, and the LX displays the following 

window shown at the following step. 

 

 

 

 

 

 

 

 

 

3. Click Update to read the TEDS transducer information.  If you turn ON the power of the LX after connecting 

the TEDS transducers, the TEDS information is automatically loaded at the initial calibration stage, and the LX 

displays this window. 
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4. Click OK when <Update TEDS information> message is displayed. 

You can view the list of the TEDS transducer information connected to the amp, such as; 

Sensitivity (sensitivity), Unit (unit), Serial number (serial), Manufacturer name (manufacturer), and 

Calibration date (cal date).  

 

 

 

 

 

 

 

 

 

Turn on the check box of the channel to reflect the sensitivity of the loaded TEDS information.  

 

 

 

 

 

 

 

 

 

 

5. Click OK to write the applicable slope value (reciprocals of the loaded sensitivity) to the header file, then 

the window is closed.  Open the channel property list at the main window to confirm the slope value is 

updated based on the loaded TEDS information.  

(See 5-16 Channel Property.) 

 

 

 

 

 

 

 

 

 

Check box 
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Auto Offset 
The auto offset function of the LX Navi measures the voltage of each channel when clicking the Auto Offset 
icon, then reflects its voltage value to the header file.  The waveform data in the LX Navi displays Y-axis data 

by adjusting to zero by using this offset value. 

 

1. Click         on the toolbar at the stop state of the LX main unit. 

 

2. The Channel Unit table is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click Auto Offset on the Channel Unit table at the timing to execute the offset.  The LX measures the 

voltages of the channels at the click timing and displays these values on the offset field.  

 

4. Click OK to apply the offset voltages displayed on the channels turning on their check boxes. 

The Confirm dialog is displayed and then click Yes to set the values.  
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Calibration By Using Calibrator 
You can use a calibrator or a pistonphone to apply a sensor sensitivity based on the actual measurement at 

the PA amp.  

 

 

1.  Click        on the toolbar at the stop state of the LX main unit. 

 

2. The Channel Unit table is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click Calibration. 

 

4. The Cal. Sound/Vibration dialog is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. After the calibration is done, click Exit or click       to return to the main window. 

 

 

 

 

Select the channel. 

Select the type of the sensor to 
use. 

Select to use RMS or Peak value for 
calibration. 

Set the output level to match to the 
calibrator to be used. 

Start calibration. 

Being displayed the progress of the calibration. 

Apply the calibration result to the slope value. 
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Zero Balance 
Whenever turning on the power, use the zero balance function at the ST amp. 

 

 

1. Click         on the toolbar at the stop state of the LX main unit. 

 

2. The Strain Zero Balance dialog is displayed to start the zero balance. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Start Zero Balance ... is displayed while implementing the zero balance of all ST amp channels at the time.  

 

 

 

 

 

 

 

4. Completed is displayed when the zero balance has been completed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. After the zero balance is completed, click Exit or click      to return to the main window. 
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ＲＸ

ＬＡＮ

SERIAL NO.

MADE IN JAPAN

Setting Tachometer Pulse Inputs 
The LX-20/20L equips two of the tachometer pulse input channels in separate of analog input channels.  

Their input connectors are located on the rear panel.   

Either 16 bits or 32 bits mode can be selected.  When you select the 16 bits mode for one channel, another 

channel is automatically effective at 16 bits mode.  In 32 bits mode, you may select only one channel.  

See Section 6 for the specifications.  

 

 1 x 16 bits tachometer pulse input channel is equivalent to 1 x analog input channel.  1 x 32 bits 

tachometer pulse input channel is equivalent to 2 x analog input channels.  Therefore, if you turn ON 

tachometer pulse input channel(s), in order keep the same analog input channels, lower the sampling 

frequency is required by following the setting of tachometer pulse input channel(s).  

 

 Set Moving Average to [1] only, when the sampling frequency of 102.4 kHz, 100 kHz, 96 kHz, 65.536 

kHz, 51.2 kHz, 50 kHz, 48 kHz, or 32.768 kHz is selected.  

 

 Only 1 x 32 bits tachometer pulse input can be selected when the sampling frequency of 102.4 kHz, 

100 kHz, 96 kHz, or 65.536 kHz is selected.  

 

 The LX Navi cannot monitor the tachometer pulse input in wave form display.  Use the distal display to 

monitor. 

 The LX cannot playback the recorded tachometer pulse input signals.  Process the data as digital data 

file. 

 

 You cannot use the tachometer pulse inputs and the generator output function at the time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For the tachometer pulse inputs
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At the System dialog, click the Tacho tab to set the tachometer pulse input channel parameters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Turn on the check box for the tachometer pulse input channel to be used and select 16bit or 32bit.  If you turn 

on both channels, the number of the bits to be set must be the same.  Other parameters are show below.  

 

Parameters (Note to refer the articles mentioned at the previous page.) 

Parameters Details 

Measurement  Measurement mode 

pulse (gate) Pulse count mode within the gate time 

pulse (total) Total counts from measurement start to stop 

Period Cycle count mode 

Frequency Frequency measurement mode 

Rpm RPM measurement mode 

Range  Measurement range 

at pulse (gate) mode 1 to 255 times of the sampling frequency 

at period mode 1m, 5m, 10m, 50m, 100m, 500m, 1 sec 

at frequency mode 10, 20, 50, 100, 200, 500, 1k, 2k, 5k, 10k, 20 kHz 

at rpm mode 1500, 3000, 6000, 9000, 12000, 15000, 18000,24000 rpm

Threshold Level Threshold level setting +0.5, +1, +2.5, +5, +10, +20 V 

Divide Rate Divide rate 1 to 255 

Moving Average Moving average setting 1 to 16 

Pulse per Rev. Pulse per revolution 1 to 255 
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Output Amp Settings 
In the System dialog, click the tab of the slot in which the output amp is installed to set the output ranges.  

<AO-8> is shown at the Slot tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Output Range Setting 

You can select the output range from 1 V to 5 V at 0.1 V steps. 

 

 In the recording at the low-speed sampling mode (1 kHz to 1/60 Hz), you cannot use the analog output 

at the output amp.  

 

 You can playback the data recorded at the low-speed sampling mode (1 kHz to 1/60 Hz) by changing 

the playback sampling frequency at 1.5 kHz or higher. 

 

 Make sure to specify the source slot installed the input amp at the Output Slot. 
 

 At the LX series, the AD value of +/- 25000 is correspondent to +/- 100 % of the input range.  So that 

the output amp outputs the signal at the scale of +/- 100% as the specified output range.  For 

example, if you record + 1V signal at the 1 V input range and you set the output range at 2 V, you will 

obtain +2 V signal correspondent to the recorded 1 V signal. 

 

Select the output ranges.

Specify a source slot of the 
input amp for output. 
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Outline of Trigger Recording 
In addition to manual operation, you can also start or stop recording automatically in the following modes. 

 

Repeat Mode 
Repeats the recording operation for a specified number of times, as shown in the following diagram.  

Recording once is also possible. 

 

 

 

 

 

 

 

 

 

 

 

 

 

<Recording-Start Conditions> 

 Level trigger 

The trigger is a change in level in a specified channel. 

 External trigger 

The trigger is a contact signal to the EXT TRIGGER IN connector on the rear of the LX. (L level: starts if 0.6 V or 

less)  If the level is already L when the system enters the recording-standby status, recording starts at once in 

memory/MO recording.  In PC recording, however, recording starts when the signal changes from H to L after 

the system enters the recording-standby status. 

 Time-out 

Recording is forced to start when the specified recording- start condition is not satisfied during a set period. 

 Pre-trigger 

A pre-trigger also records the data that was read into a buffer before one of the above recording-start conditions 

was satisfied.  The voice memo is not recorded during the pre-trigger period. 

 

<Recording-Stop Conditions> 

 Level trigger 

The trigger is a change in level in a specified channel. 

 External trigger 

The trigger is a contact signal to the EXT TRIGGER IN connector on the rear of the LX. (H level: stops if open or 

2 V or more) 

 Recording time 

Records for a specified period only. 

 Post-trigger 

Continues to record for a set period even after a recording-stop condition is satisfied. 

 

 

 To cause a trigger action, click        

in the toolbar or press the REC button 

on the main unit to put the system in 

the recording-standby status. 

 Even if a trigger action is enabled, the 

buttons on the toolbar and main unit 

are not disabled. 

Start Stop 
Pre-trigger Post-trigger

Recording start 
condition is satisfied: 
Level trigger 
External trigger 
Time out 

Recording strop 
condition is satisfied: 
Level trigger 
External trigger 
Recording time 
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Interval Mode 
Repeats the starting and stopping of recording for a specified number of times, during a specified period.   

Recording once is also possible.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(Example: When repeating 3 times) 

Stop
Specified recording time 

Specified time 

Specified pause time

Start Start StopStop Start 
Specified pause time Specified recording time Specified recording time
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Repeat Mode Settings 
To specify trigger action settings, from the Setup menu choose Trigger. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The settings in the above dialog box use a level trigger to start recording and an external trigger to stop 

recording.  A 10-second pre-trigger is specified, and recording is done once.  

 

Pre/Post 
Select this to enable a pre-trigger or post-trigger.  When Pre/Post is selected but the lower Repeat is not selected, the 

pre-trigger is enabled for starting recording by operations that use the toolbar or the buttons on the LX main unit. (The 

post-trigger is not enabled for stopping recording by operations that use the toolbar or the buttons on the LX main unit.)  

 

Start PreTrig/Stop PostTrig 
Specify the length of the pre-trigger or post-trigger in seconds or in scan units.  To switch the units, click a button on the 

right.  When 0 is entered, the pre- or post-trigger is disabled.  Specify a value that does not exceed the time possible 

using available free memory.  

 

 

 

 

Switch between seconds and scans.

Enable pre- and post-triggers. 

Specify the length of the pre-trigger. 

Use a level trigger to start recording. 

Enable the repeat mode.

Use an external trigger to 
stop recording. 

Number of repetitions. 

Set the level trigger (next 
page). 

Set the recording time.
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Repeat 
Select this to enable the Repeat mode. 

 

Start Condition 
Specify a recording-start condition.   If multiple conditions are set, the first condition satisfied will start recording. 

Level: Select this to enable a level trigger.  You can set level trigger details in the dialog box displayed by choosing 

Level Trig and then Property. (See the next page.) 

External: Select this to enable an external trigger. 

Timeout: If a level trigger or external trigger has been enabled, you can force recording to start if a specified 

recording-start condition is not satisfied during a specified period.  Specify the period in seconds.  When 0 is entered, 

Timeout is disabled.  

 
Stop Condition 

Specify a recording-stop condition.  If multiple conditions are set, the first condition satisfied will stop recording. 

Level: Select this to enable a level trigger.  You can set level trigger details in the dialog box displayed by choosing 

Level Trig and then Property. (See the next page.) 

External: Select this to enable an external trigger.  

RecTime: Enables you to stop recording after a set period has elapsed from the start of recording.  You can set the 

period in the dialog box displayed by clicking the button.  After you have entered a period, the period is displayed in 

this area.  

 

 Make sure to turn the trigger signal level to High before the next start, when you are using an external 

trigger for start with a repeat recording by using REC TIME.  

 

Repeat Count 
Specify the number of times the trigger recording operation specified above is to be repeated.  A file is made for each 

of the specified number of times. You can also specify 1 time only.  Specifying 0 will result in an unlimited number of 

repetitions (repetitions until you manually stop recording).  
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Level Trigger Settings 
To specify the details of the level trigger, click Level Trig – Property. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The settings in the above dialog box are such that recording starts when the input signal of channel 2 crosses 

from lower than +50% of the specified input range to higher than +50%, AND, the channel 3 signal crosses 

from lower than +50% to higher.  Recording stops when the input signal of channel 2 crosses from higher than 

-20% of the specified input range to lower than -20%. 

 

Channel selection 
In the list of channels, click the desired channel.  Alternatively, select the channel from the drop-down list box in the lower 

left of the window.  

Select the cross direction: 
Up: The condition is regarded as having been satisfied when the input signal crosses from lower than the specified level to 

higher.  The condition is regarded as not having been satisfied if the specified level was already higher when the 

recording-standby status was entered. 

Down: The condition is regarded as having been satisfied when the input signal crosses from higher than the specified 

level to lower.  The condition is regarded as not having been satisfied if the specified level was already lower when the 

recording-standby status was entered.  

Ignore: The channel is not monitored for the level trigger. 

Level settings 
The full scale of the specified input range is set to 100% on both the plus and minus sides.  You set the monitoring level 

for these in the range from -99% to +99%.  Enter a minus sign (-) for minus values. In the above dialog box, when the 

input range is 10 V, 50% becomes 5 V and -20% becomes -2 V.  

Logic 
When multiple channels are monitored for Start and Stop, specify whether these are combined using a logical AND or 

logical OR.  

Number of times condition is satisfied 
Specifies how many times a condition is regarded as having been established when a condition specified above (including 

the logical operator) is satisfied multiple times. 

Switch the logical operator. Number of items condition is satisfied. 

Click the channel you 
want to set. 

You can also select a channel here. 

Select the cross direction. 

Level settings. 
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Interval Mode Settings 
You can set trigger-action details in the dialog box displayed by choosing the Setup menu and then Trigger.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The settings in the above dialog box specify that there are to be 4 recordings, each of which shall begin 

every hour on the hour from noon on August 15, 2001 and end in 5 minutes. 

 

Interval 
Select this to enable the Interval mode. 

 

Start Time 
Specify the date and time when the interval action is to start. 

 

Rec Time 
Clicking this displays a dialog box in which you can specify the recording period. The value you set is 

displayed in this area.  

 

Interval Time 
Specify the interval to wait before recordings. (Note that this is not the cycle period.)  Clicking this displays 

a dialog box in which you can specify the interval.  When recording to the media, the interval must be three 

seconds or longer; to memory or a PC, one second or longer.  The value you set is displayed in this area.  

 

Repeat Count 
Specify the number of times recording is to be repeated.  A file is made for each of the specified number of 

times. You can also specify 1 time only.  Specifying 0 will result in an unlimited number of repetitions 

(repetitions until you manually stop recording).  

 

Enable the interval mode. 
Specify the date and time of 
starting the interval action. 

Recording period

Pause period

Number of repetitions.
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Saving and Loading Settings 
The parameters that you set after choosing the Setup menu and then System and Trigger can be saved to a 

file and then loaded whenever required.  When you choose Params Property from the Setup menu, the 

following dialog box is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Saving Settings 
You save the set parameters as a file that has a .prm extension.  We recommend that you save your settings to 

avoid potential problems.  

 

1. Click Save at the Params Property dialog. 

 

2. When you select the LX (the media loaded into the LX main unit) for the destination to save, the LX 
Parameter File List dialog will be displayed.  Enter the file name to save the setting parameters at the bottom 

of the dialog, or select the file name to be changed its parameters, and then click OK.  

 

 

 

 

 

 

 

 

2. When you select the PC for the destination to save, the Save As dialog will be displayed.  Enter the folder 

to save and the file name, and then click [Save(S)].  

 

 The setting parameter file is saved as ASCII format, so that you can open the file by using the word pad 

program of Windows.  Never replace the contents, otherwise you cannot load the file at the LX.  

 

 

Load the settings.

Save the settings.

System information

Settings for each 
channel 

Select the load and save 
destination of a setting 
parameter file.

Loaded file
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Loading Settings 
Load the prm file once saved. 

 

1. Click Load at the Params Property dialog. 

 

2. When you select the LX (the media loaded into the LX main unit) for the destination to load, the LX 
Parameter File List dialog will be displayed.  Select the file name to load its parameters, and then click 

OK. 

 

 

 

 

 

 

 

 

The loaded file name is displayed at Params Property dialog. 

 

2. When you select the PC for the destination to load, the Open dialog will be displayed.  Enter the folder 
to load and the file name, and then click [Open(O)].  
 

The loaded file name is displayed at Params Property dialog. 

 

3. Click OK at the Params Property dialog. 

The LX will be set at the contents of the loaded file. 
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Specifying Recording Devices and File Names 
The general procedure for recording is as follows: 

1.  Choose File → New, and specify the recording device and the file name. (The mode becomes the 

recording mode. 

2. Use the toolbar or the buttons on the main unit to record. 

3. If you are recording to the memory, use the Copy dialog to copy to the media (MO/PC card). 

 

A combination of the sampling frequency vs. the number of analog input channels is varied depending on the 

selected recording mode, such as, the type of the recording media and the number of tachometer input 

channels.  See”1-13 Sampling Frequency and Number of Channels”.  

 

File → New 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Automatically save to the media after the 
recording to the memory stops. 

Simultaneously 
recording to PC. 

Select the storage 
destination. 

File name when using PC.

File Name 
(5 characters.) 

Specify the directory on 
the media. 

History of storage 
destinations. 

Comment (128 
characters) 

Specify the number 
of digits in the ID 
number. 

You can also select the recording device here.

Specify the PC directory.
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 About File Names 

When Recording to Memory or to Media 

To specify a file name, use 5 alphanumeric characters.  The following characters cannot be used :  

 

．，；：<> [ ]*? ="/ \  |    
       

The system attaches a 3-digit ID number (starting from 001) to these 5 characters to make a total of 8 

characters.  If you specify 4 or fewer characters, the system changes the total number of characters to 8 by 

using a 0 before the 3-digit ID number to pad each of the missing locations. 

 

 When Recording to a PC 

When recording to a PC, or when recording to a PC while recording to memory or media, there is no restriction 

on the length of the file name. The following characters cannot be used :  

 

．，；：<> [ ]*? ="/ \  | 
 

In the entry box on the right of the file name, you can choose how many digits to use for the ID numbers 

appended to the file name.  Use up to 8 digits for the ID number. For example, if you enter 2 in the entry box, 

Data files have the extension .dat. Header files have the extension .hdr. 

 

 Data files have the extension .dat.  Header files have the extension .hdr. 

 Do not add numeric characters to the end of a file name.  If you do so, the following problem might occur. 

 

Example:  

Suppose you specify the file name as "LX10", the 8-character file names are constructed as follows: 

 

         LX100001 

            ↓Increment 

         LX100002 

            ↓Increment 

         LX100003 

 

If you then specify a new file as "LX1" and record it to the same folder, the system will find that there is an 

existing file called LX100001 and so, to prevent overwriting this file, the system will use LX100004 as the new 

file name.  

 

 About Comments 

You can enter a comment using up to 128 alphanumeric characters.  This comment is written into the header 

file. 
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Recording to Memory 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you are recording to memory, the message Do you copy data? is displayed after recording stops.  If 

you click Yes, the Copy dialog box is displayed.  Use this dialog box to copy the data to the media or PC.  

If you again record data or power off the main unit before copying, the data in memory will be lost. 

 

If you click No for the message Do you copy data?, you can choose File then Copy to copy the data before 

again recording or powering off the main unit. 

 

1. Select New from the File menu. 

 

2. Select <MEMORY> as the storage destination. 

 

3. Type a file name within 5 characters at Dataset.  

 

4. Click OK.  

 

File name 

Select MEMORY. 

Specify the number 
of digits in the ID 
number. 

Simultaneously 
record to PC. Automatically save to the media after the 

recording to the memory stops. 

You can also select MEMORY here. 

File name when using PC. 

Specify the PC directory.
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 When Memory Becomes Full 

If memory becomes full during recording, recording stops and a message is displayed on the PC screen. 

 

 Recording to a PC While Recording to Memory 

To record to a PC while recording to memory, select PC Recording, enter the storage-destination directory in 

PC, and then type the file name in the entry box below that.  Also specify the number of digits in the ID 

number.   

Dropouts may occur in the data recorded on the PC if the PC cannot keep up with the transfer speed.  Even in 

this case, the data recorded in memory is not lost.  If the data transfer rate of the PC does not catch up the 

data transfer rate of the LX, the dropout will occur.  The data transfer rate of the PC required for continuing the 

data transfer to the PC can be estimated that the PC needs to receive approximately 1.5 times of 10 seconds 

data generating by the data transfer rate of the LX within 10 seconds. 

 

Data transfer rate of the LX = Sampling frequency x Number of channels x 2bytes/second 

 

The voice memo is not recorded on the PC though it is kept in memory. 

 

 Automatically Save Data to Media 

You can specify that data is to be automatically saved to the media after recording to memory stops.  Before 

opening this New dialog box, insert the media.  Select Auto Saving and enter the folder name in Directory. 

Use up to 8 characters for the folder name, with upper case used for alphabetic characters.  However, if you 

forget to insert the media before recording starts, you will be unable to copy automatically even if you insert the 

media later.  In such a case, use File and then Copy to copy. 

 

Even if Auto Saving is selected, when the LX is powered off the setting is disabled.  So select Auto Saving 

each time you turn the power on.  Do not use this function when using the LX as a stand-alone device because, 

in such a situation, the system does not know how much free space is left on the media. 
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Recording to Media (MO/PC Card) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When recording with a maximum sampling frequency can be set under the selected channel configuration, 

use a formatted media that has not been used for recording.  If you use the media that has already been 

recorded on, recording might stop.  

 

1. Make sure that a formatted media is inserted in the main unit. 

 

2. From the File menu choose New.  

 

3. Select a folder on the media as the storage destination.  When using the media for the first time, enter 

a folder name in Directory.  For the folder name, use up to 8 characters (alphabetic characters are 

upper-case). 

 

4. In Dataset, enter a file name.  Use up to 5 characters.  

 

5. Click OK. 

 

 Recording to the media cannot start if no media has been inserted. (The REC button has no effect.)  

 

You can also select the media here. 

Select the folder on 
the media. 

File name when using PC. 

File name 

Specify the 
directory on the 
media. 

Specify the PC directory. 

Simultaneously record to PC.
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 Recording to a PC While Recording to Memory 

To record to a PC while recording to memory, select PC Recording, enter the storage-destination directory in 

PC, and then type the file name in the entry box below that.  Also specify the number of digits in the ID 

number.   

Dropouts may occur in the data recorded on the PC if the PC cannot keep up with the transfer speed.  Even in 

this case, the data recorded in memory is not lost.  If the data transfer rate of the PC does not catch up the 

data transfer rate of the LX, the dropout will occur.  The data transfer rate of the PC required for continuing the 

data transfer to the PC can be estimated that the PC needs to receive approximately 1.5 times of 10 seconds 

data generating by the data transfer rate of the LX within 10 seconds. 

 

Data transfer rate of the LX = Sampling frequency x Number of channels x 2bytes/second 

 

The voice memo is not recorded on the PC though it is kept in memory. 

 

 When Media Becomes Full 

If media becomes full during recording, recording stops and a message is displayed on the PC screen. 

 

 Formatting Media 

A specified MO disk is not formatted.  Use the following procedure to format the MO disk the first time you use 

it. You cannot record to the MO disk by overwriting files.  If the MO disk becomes full and the data is not 

needed, reformat the MO disk. 

You can also format the PC card as same as you format the MO disk. 

 

1. From the File menu of LX Navi, choose Format.  The following dialog box appears.  

 

 

 

 

 

 

 

2. In Volume, enter the volume name.  Use up to 8 characters. 

 

3. Click Format. 
 

4. When the displayed status changes from Now Formatting to Complete, formatting has finished.  Close the 

dialog box. 

 

Use FAT16 option whenever formatting the PC card under Windows operation. 

Do not use FAT32 option for formatting the card. 
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Recording to PC 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. From the File menu, select New.  

 

2. Select a PC folder as the storage destination.  

 

3. Type the file name.  

 

4. Specify the number of digits in the ID number.  

 

5. Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the storage 
destination folder. 

File name Specify the number of 
digits in the ID number.

When selecting here, select NO DEVICE.

Specify the directory.
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Caution on reproducing files recorded to a PC using the LX main unit  
 
Follow the procedure below in order to record using a PC, to copy recorded files inside a PC to an MO or PC 
card and to reproduce recorded data properly, using the LX main unit.   

 

1. When the PC recorded file has a long file name, change it to a short file name on the PC HDD (8 letters 

+ 3 extension characters for the file name).Change 1 group of recorded data (data file, header file, web file) 

to the same file name, and leave the extension name as it is. Half-width alphanumeric characters and 

half-width sign characters may be used for file names. The following characters cannot be used :  

 

．，；：<> [ ]*? ="/ \  | 
 

2. Create a directory on the PC HDD, inputting an 8 character or less directory name, (e.g. “LX10_DIR”), 
and copy the short file name of the LX recorded data file.  
 

3. After formatting media on an MO or PC card using the LX main unit, place the media into the MO drive or 
PC card slot connected to the PC.  
 

4. There is a sub directory in the root directory of the MO or PC card called “TEAC_LX” 
  Copy each directory made in step 2 under the “TEAC_LX” directory here.  
     \     (Media root directory) 
        ¦ 

        TEAC_LX (automatic created when formatted using the LX main unit) 
          ¦ 

          LX10_DIR (copy the directory on the PC)  

        ・  (multiple directories possible) 
         

 

 

 

The total size of files you wish to copy (data files, header files, and web files) may be larger than the MO or 
CF card capacity, in which case, reproducing may not be possible using the LX main unit.   
 

Data recorded with the LX-20 tacho channel enabled, may corrupt reproducing data, in which case, normal 
waveform regeneration is not possible using LX10 (F).(This also applies to direct recording using LX main 
unit media)  
 

Immediately after purchasing a PC card use a PC to format the file system to FAT (FAT16) before use. If 
formatting is not carried out, normal use may not be possible under LX. 
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Recording Operations 
When you choose File and New, and then select the recording device and the file name, the mode becomes 

the recording mode and you can start recording. 

The following procedure shows how to record two IDs.  Also, during recording, we will mark data by adding 

event marks to the data.  

 

1. Ensure that the mode shown in the status display is RECORD.  If it is VIEW, click the REC button on the 

far left of the window to change the mode to RECORD.  

 

2. If data is saved automatically to the media after recording to memory stops (that is, Auto Saving is 

selected), or when recording to the media, ensure that the media is inserted. 

 

3. Click the      button on the toolbar.  Alternatively, press the REC button on the main unit. 

 

The action display will show RECSTANDBY, and the input waveform will be displayed in the waveform display 

area.  

 

4. After 3 seconds, click       on the toolbar.  Alternatively, press the FWD button on the main unit. 

 

The action display shows REC and recording starts.  When recording to memory or recording to the media, 

the USAGE LEDs show the percentage of the total capacity used.  

 

5. Click      on the toolbar.  Alternatively, press the EVENT button on the main unit. 

 

The display of the event mark count will show 0001.  The number of scans at this instant is recorded in the 

header file.  If a new event mark is not separated by the previous mark by 2 or more seconds, the mark is 

not valid.  

 

6. Click      on the toolbar.  Alternatively, press the PAUSE button on the main unit. 

 

The recording of the first ID ends, and the system enters the pause status.  The action display shows 

RECSTANDBY. 

When recording to the media, you cannot perform another recording until the system has finished writing to 

the media.  

 

7. Click     on the toolbar.  Alternatively, press the FWD button on the main unit. 

 

Recording of the second ID starts. 

 

8. Click      on the toolbar after 3 seconds or more.  Alternatively, press the STOP button on the main 

unit. 

 

Recording stops. 

 

If you record a voice memo in PC recording, put the system in the recording-standby status by clicking     

or pressing the PAUSE button before you stop recording.  Otherwise, the voice is not recorded.  
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9. When recording to memory, the message Do you copy data? is displayed after recording stops.  If you click 

Yes, the Copy dialog box is displayed. Use this dialog box to copy the data to the media or PC. (See the next 

page for details.) If you again record data or power off the main unit before copying, the data in memory will be 

lost.  Or the data in memory will be lost if you playback. 

If you have selected the Auto Saving option (after choosing File and then New) and the media has been 

inserted, the above message is not displayed and the data in memory is automatically saved to the media. 

The above procedure records the files shown in the following diagram. 

 

 

 

 

 

 

 

 

 

 

 

Exchanging Media 
 When Recording to Media 

When the media becomes full during recording, a message is displayed and recording stops.  The file up to that 

point is made.  You can replace the media and again start recording.  

 

 When "Auto Saving" Is Selected 

When the media becomes full during copying, a message is displayed and copying stops.  The file up to that 

point is made.  If you then replace the media, the remaining data will not be copied automatically.  In such a 

case, use the Copy dialog box to copy the remaining data.  After replacing the media, you can again start 

recording.  

 

 Directory and ID Number After Media is Replaced 

When the media is replaced, the directory and file name specified in the New dialog box are made on the media 

and data is recorded; however, the ID number again starts from 1.  Also if the directory or file name specified 

in the New dialog box already exists on the media, the last ID number is incremented by 1 and the new 

sequential ID number is used.  

 

 

 

 

 

 

 

 

REC FWD PAUSE FWD STOP 

EVENT 

Aaaaa001.dat
Aaaaa001.hdr

Aaaaa002.dat 
Aaaaa002.hdr 
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Copying 
Recorded data files can be copied in the following three directions: 

 

Memory to Media 

Memory to PC 

Media to PC 

 

 When a data file is copied, the header file paired with the data file and also the sound file are copied at 

the same time.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. From the File menu, choose Copy. 

 

2. Select the copy source device or folder to be copied. 

 

3. Select the data file to be copied by turning the check box of the data file ON.  

 

4. In Device, click MEDIA to copy to the media and click PC to copy to the PC. 

 

5. In Directory, specify the copy destination directory. 

 

6. Click Store. 

 

 If you are copying from memory, data will remain in memory even after copying has finished, so the 

USAGE LEDs will remain lit.  

 

 Changing File Name When Copying (Valid only when copying to the PC) 

When changing a file name, click the file that you want to change.  The file will be highlighted.  In 

Dataset, type the name of the file after the change.  The name of the file after the change is displayed in 

Copy Name. 

 

 The DATASET in the copied header file keeps the original file name.  See Section 6 File Formats for 

details of the header file.  

Select the device at the copy source. 

Select the file(s) to be copied. 

Select the device at the copy destination.

Specify the directory. 

Specify the file name. 
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Reproducing 
You can reproduce data that has been recorded to memory or media. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. From the File menu choose Open. 

 

2. Select the file to be reproduced. 

 

3. Click OK.  (The mode in the status display becomes VIEW.） 

 

4. Click      on the toolbar.  Alternatively, press the FWD button on the main unit. 

 

The action display changes to PLAY, and reproduction begins. 

 

 Changing Reproduction Rate 

You can reproduce data at a different rate from recording rate.  To change the rate, first open the file by 

following the steps described on the left, and then change Sample setting on the left of the main window, or 

from Setup menu choose System and change Sample setting. 

 

Changing the reproduction rate does not change the sampling frequency setting for recording. 

 

The rate of voice memo reproduction is not changed even when Sample setting is changed.  In this case, the 

data and the voice do not synchronize. 

 

At the LX-20/20L, changing the reproduction rate is possible within the same sampling frequency series. 

 

The recorded file under the low-speed sampling (1 kHz to 1/60 Hz) can be reproduced by changing the 

reproduction rate at 1.5 kHz or higher. 

Directory path opened 
previously. 

Specify the directory 
to be opened. Select the file to be 

reproduced. 

File name to be 
reproduced. 

Comment recorded 
on the header file. 

Select the reproducing mode. 
Single: Reproduce the specified file. 
Repeat: Reproduce the specified file repeatedly. 
Continue: Reproduce the specified file, and then to 
the next files automatically. 
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Reproducing Operations 
At the LX Navi                                         At the LX main unit 

 

 

 

 

 

 

 

 

 

 

 

The skip functions are available during a pause or in the stopped status.  For details, see the next. 

 

 

Moving Reproducing Point (Skip) 
Skipping enables you to move the reproduction point.  The skip function is available in the paused or 

stopped status.  When you click the      button, the reproduction point moves from the current location 

to the previous point.  When you click the     button, the reproduction point moves from the current 

location to the following point. (Displaying of a waveform is from the start or restart of reproduction after a 

skip.) 

 

You can specify the range of the movement by one click. 

 

To specify the range of the movement click      on the toolbar.  The following dialog box is displayed. 

 

 

 

 

 

 

 

 

You can select from the following 4 options: 

File 
Moves from the current file to the older file (determined by ID number) in the same folder. 

Scan 
Moves the specified number of scans only.  When you select Scan, the lower box displays the total number 

of scans of the current file. 

Mark 
Moves to the preceding or following event mark.  When you select Mark, the lower box displays the total 

number of event marks in the current file.  

Time 

Moves the selected time (hours:minutes:seconds).  When you select Time, the lower box displays the time 

when recording to the current file started, and the time when recording to the current file ended.  

Skip to previous 

Skip forward 

Stop by returning the 
beginning of the file. 

Start reproduction, re-start 
reproduction after pause or 
skip. 

Pause at the 
current position. 

Total number of scans of the 
current file, etc. 

Start reproduction, re-start 
reproduction after pause or 
skip. 

Stop by returning the 
beginning of the file. 

Pause at the current 
position. 
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Searches 
You can narrow searches by using the status display area. 

 

1. With the View mode set in the paused or stopped status, click on any of the status-display boxes indicated 

by arrows in the following diagram.  After the color of the characters changes, click again.  

 

 

 

 

2. Specify the goal of the search. 

 

Event search 

Searches for the specified event mark.  

The lower 2 boxes show the range of values  

that can be searched. 

 

 

 

 

Count search 

Searches for times (hours: minutes: seconds) from  

the start of recording.  

The lower 2 boxes show the range of values that  

can be searched. 

 

 

 

Time search 

Searches using your specified recording date and time.  

Enter the date (year/month/day) and  

time (hour: minute: second).  

The lower 2 boxes show the range of values that  

can be searched. 

 

 

 

3. After specifying the goal of the search, click the close button to close the dialog box.  At the goal point, the 

system enters the stopped status. 

 

4. Click     on the toolbar.  Data is reproduced starting from the goal point. 
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Convenient Features 
Displaying Waveform 
You may see the decimated plots on the viewing waveform depending on the sampling frequency settings 

and/or the display time scale.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sampling Frequency Display Period 

 1.5 kHz Up to 10 s 
 3 kHz Up to 5 s 
 6 kHz Up to 2 s 
 12 kHz Up to 1 s 
 24 kHz Up to 500 ms 
 48 kHz Up to 200 ms 
 96 kHz Up to 100 ms 
(In case 1.5 kHz to 96 kHz sampling 
frequencies are selected.) 

View overlapping waveforms Select the channel to display 

Click to return to 
the original. 

The channel is 
displayed on top. 

Select the graph you want to display on top. 

Display all channels.

Arrange the graphs in the order of channels.

Display all the graph in a window.

Select the channel 
you want to display. 

Click CH, click again to erase. 
Change the size 
of the graph’s 
horizontal 
direction. 

Drag and drop the box with the channel 
number to another channel 

Slider to change the time axis

Display the time axis grid of the cursor 
location.  C1-C2 is the time 
difference.  During a pause, you can 
move this by dragging the cursor. 

Click here to display 
the list on the next 
page, click again to 
erase. 
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Channel Property 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Converting Units 

You can use engineering units instead of the physical units to be written in the VERT_UNITS line of the header 

file.  The coefficient (SLOPE value) is accordingly converted and written in the header file. 

In the above dialog box, the entered conversion expression is for the situation where you are recording a signal 

from an acceleration sensor outputting an acceleration of 9.8 m/s2 by 1 V.  When there is an offset value for 

when the input is 0 V, type the value in Offset value.  When these are changed, in the header file the units for 

VERT_UNITS and the SLOPE and Y_OFFSET values change. 

 

Disp Range 
Dragging the slider changes the waveform graph range. 

Channel Name 
You can name each channel. 

Line Color 
Selects the color of the graph lines.  Clicking Same changes the graph lines of all graphs to the same color.  

Back Color 
Select the background color of a graph.  Clicking Same changes the background of all graphs to the same 

color. 

Value of cursor position Differences between 2 cursor position values 

Double click the desired channel. 

Coefficient value and units

Unit conversion expression 

Offset value 

Return to the default. Return to the default. Change the display range.

Channel name 

Graph back ground color

Graph line color

Reset the graph color settings to 
the default. 
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Displaying Bar Meter 
To display the bar meter, choose View and then Bar. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Displaying Digital Values 
To display digital values, choose View and then Digit. 
 

 

 

 

 

 

 

 

 

 

 

Viewing Header Information 
To display header information, choose View and then Hdr.  This takes effect after you select a file in the 

View mode.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Switch between % and dB. Clear the peak hold. 

Use the slider to change the 
width of the dark blue part.  
This is convenient as a level 
monitoring estimate. 

Add a channel. 

The channel name and units 
Set in the Channel Property 
window. 

Select a channel. 
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Changing Modes 
In the lower left of the main window, you can see the recording device and the file name, and select the file to 

be reproduced. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Switch between the recording mode and view mode. 

<In Recording mode> <In View mode> 

Display the storage location and file name.

Select the file to bereproduced. 

Comments written using File and New.  Comment written in the file being 
reproduced. 

Select the sampling frequency. Select the reproducing rate.

Select the monitoring channel. Select the monitoring channel.

Period recordable on the selected 
device (hours:minutes:seconds) 

Period recordable on the PC 
(hours:minutes:seconds) 

Serial number or recorder name of the 
LX target  
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Stopping Fan 
You can stop the cooling fan on the LX by clicking the fan button on the toolbar. (If you have already stopped 

the fan and recorded data, wait for about 10 minutes before you again stop the fan and record.) This button 

behaves differently depending on the Fan setting in the System dialog.  

 

 

 

 When Fan is set to ON 

The fan button is enabled after the recording-standby status is established.  By clicking the button you can 

stop the fan from that moment until you click it again.  You can repeat this until the total fan-stop time is 10 

minutes. The remaining fan-stop time is shown on the status display.  

 

 When Fan is set to OFF 

The fan button is enabled only during the recording-standby status.  By clicking the button you can stop the 

fan only once for the maximum of one minute.  The remaining fan-stop time is shown on the status display. 

After you start recording, the fan button is disabled and the cooling fan is stopped for 10 minutes.  

 

 

Listening to Data by Sound 
You can play back the data of the monitored channel as sound by clicking the speaker button on the toolbar. 

When you click this button during reproduction, the data of the monitored channel instead of a voice memo 

is played back from the speaker.  
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LX Stand-alone Operations 
The last settings specified by LX Navi (such as the recording device, file name, and other settings) are stored in 

the LX main unit even if the power is turned off.  When the LX is removed from the PC, the LX operates 

according to those settings.  

 

 Cautions on Operating as a Stand-Alone Device 

IEEE 1394 enables hot-pluggable connections, so the LX-10/20 main unit can be connected or disconnected 

while the PC is powered on. (However, do not disconnect the LX-10/20 main unit while it is communicating with 

the PC.)  When the LX-10/20 is disconnected, LX Navi outputs an error message and terminates.  In such a 

case, if you reconnect the LX-10/20 and restart LX Navi, the LX-10/20 can again be recognized. 

 

When moving the LX main unit, remove the media before turning off the power.  Moving the unit while the 

media is inserted might result in damage. 

 

When recording to the media, insert a formatted media before opening (File then New) the New dialog box. 

Also ensure that the same media is inserted before recording starts.  If no media is inserted, recording cannot 

start (the REC button has no effect).  

 

When recording to memory, after recording stops and while the power is still turned on, connect to a PC and 

copy the data to the media or PC.  If you again record data, reproduce data, or power off the main unit before 

copying, the data in memory will be lost.  

 

 When recording to memory using LX as a stand-alone device, do not select the Auto Saving option (File, 

New, and then Auto Saving).  When recording to memory, the system does not know how much free 

space is left on the media, so there is a danger that some data might be lost when saving.  Also note that, 

even if the Auto Saving option is selected, powering off the LX resets this option to the disabled status. 
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Recording to Media 
1. Insert the media in the LX. 

 

2. In the LX Navi, from the File menu choose New. 

 

3. Select the MO/PC CARD as the recording device, specify the directory and file name, and then click OK. 

 

4. Eject the media, and terminate the LX Navi. 

 

5. Power off the LX, remove the IEEE 1394/LAN cable from the rear, and move the LX to the place where 

you want to take measurements. 

 

6. Power on the LX and insert the same media. 

 

7. Press the REC button and then the FWD button.  Recording will start. 

 

8. Press the PAUSE button. 

Recording will pause.  Recorded data will be grouped into one ID. 

After this, each time the FWD and PAUSE buttons are pressed, an ID will be recorded, and the ID numbers 

will be incremented automatically.  

 

9. To stop recording, press the STOP button. 

 

10. When writing to the media finishes, the eject button eject usable.  When moving the main unit, first 

press the eject button and remove the MO media.  Remove manually on the PC card media.  

 

 After the above, if you turn off the power and then turn it back on and record to the same media, the ID 

number will be automatically incremented and data will be recorded to the same file name.  In the 

example illustrated in the diagram below, the file will become Aaaaa003.  

 

 

 

 

 

 

 

 

 

When the media becomes full 

When the media becomes full during recording, the recording stops and the data up to that point is made 

into a file.  You can then replace the media and restart recording.  If you are using the LX as a stand-alone 

device, you cannot format the media so prepare formatted media beforehand.  On the new media, the 

system will make the directory specified in the New dialog box and use the specified file name; however, the 

ID number will again begin from 1.  Also if the directory or file name specified in the New dialog box 

already exists on the media, the last ID number is incremented by 1 and the new sequential ID number is 

used.  

 

REC FWD PAUSE FWD STOP 

Aaaaa001.dat 
Aaaaa001.hdr 

Aaaaa002.dat 
Aaaaa002.hdr 

Standby Start ResumePause Stop 
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Recording to Memory 
When recording to memory while using LX as a stand-alone device, after recording stops keep the LX powered 

on, connect to a PC, and transfer the data in memory to an MO disk or the PC.  

 

1. In the LX Navi, from the File menu select New.  

 

2. Specify memory as the recording device, specify the file name, and then click OK.  

 

3. Terminate the LX Navi. 

 

4. Power off the LX, remove the IEEE 1394/LAN cable from the rear, and move the LX to the place where you 

want to take measurements.  

 

5. Power on the LX. 

 

6. Press the REC button, and then press the FWD button.  Recording starts.  

 

7. Press the PAUSE button. 

Recording will pause. Recorded data will be grouped into one ID.  

After this, each time the FWD and PAUSE buttons are pressed, an ID will be recorded, and the ID numbers will 

be incremented automatically.  

 

8. To stop recording, press the STOP button. 

 

 Take care in this situation because the data in memory will be lost if you again press the REC button, start 

reproducing, or power off the LX.  

 

9. Use an IEEE 1394/LAN cable to connect to the PC. 

 

10. Start the LX Navi. 

 

11. From the File menu choose Copy, and copy the data recorded to memory to the PC.  

 

 When recording to memory using LX as a stand-alone device, do not select the Auto Saving option (File, 

New, and then Auto Saving).  When recording to memory, the system does not know how much free 

space is left on the media, so there is a danger that some data might be lost when saving.  Also note that, 

even if the Auto Saving option is selected, powering off the LX resets this option to the disabled status. 
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Reproducing 
Even when using the LX as a stand-alone device, you can reproduce and output the last data (last ID) 

recorded to memory or to the media.  However, when the power is turned off, any data in memory will be 

lost and you will be unable to reproduce such data. 

To reproduce data, press the FWD button on the front of the LX.  

To pause reproducing data, press the PAUSE button. 

To stop reproducing data, press the STOP button.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Return to beginning and stop.

Stop at that position.

Start reproduction, or restart 
after a pause. 
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Recording Synchronization 
This section explains the optional recording synchronization function of the LX multiple units. 

The LX Navi sets a master unit and up to 3 slave units connected with the recording synchronization cable 

within the total of 10 m (as of November 2005) for recording synchronization recording.  

 

 The following PC (personal computer) system specifications are necessary for the recording 

synchronization function. 

 

OS: Windows XP / Windows 2000 

CPU: Pentium Ⅳ 2.0GHz or better 

Memory: 256Mbyte or more 

Free HDD space: 2Gbyte or more 

LX Navi version: V1.71H or later。 

 

 If you use the IEEE1394 interface model of the LX and you need to update the LX Navi, update the device 

driver to the latest (see Section 2). 

 

 You cannot use the IEEE1394 interface model and the Ethernet interface model mixed for the recording 

synchronization.  

 

 When the recording synchronization function is enabled and LxNavi is started up, the reproducing 

operation cannot be used. Before using the reproducing operation, re-launch LxNavi, disabling the 

master/slave settings and execute it as an independent unit.  

 

 Change the settings of the sampling frequency of recording and the recording media destination (Memory, 

MO, PC card) to that of the master unit and slave unit. When controlling the master unit and slave unit 

using a single PC, (simultaneously launching multiple units with LxNavi using recording synchronization) 

set the directory name and file name of the file to be recorded, so they do not duplicate. 

 

 When controlling the master unit and slave unit using a single PC, limitations may occur in the operation 

of the maximum sampling frequency and in the save function of Lx Navi settings content.  

 

 When using recording synchronization, launch LxNavi operations in order; master unit, slave 1, slave 2, 

etc. When ending the program, end operations in the opposite order to which they were started and lastly 

close the LxNavi master unit. 

 

 Use the optional LX Ｖｉｅｗ PL-S1001 wave monitor software or the AFC NEO PL-S1002 file converter 

software to merge the multiple files recorded. 

 

 Keep minimum numbers to open the main windows of the slave units; otherwise the real time monitor 

cannot be processed depending on the selected sampling frequency. 
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ＲＸ

ＬＡＮ

SERIAL NO.

MADE IN JAPAN

 

Settings and Recording Operations 
Use the LX Navi menu of each master/slave unit for the amp and input range parameter settings, the sampling 

frequency, and so on.  Make sure to use the same sampling frequency and the recording media for the units to 

be recording synchronized. 

Use the LX Navi of the master unit to start and stop recording synchronization, the slave units follows start/stop 

operation of the master unit.  

 

 
Connecting Recording Synchronization Cables and Turning on Power 
1. Connect among the LX units to be synchronized by using the synchronization cables. 

 

 

 

 

 

 

 

 

 

 

 
The <SYNCHRO IN> connector and the <SYNCHRO OUT> connector are used for recording synchronization. 
Connect the <SYNCHRO OUT> connector of the first unit to the <SYNCHRO IN> connector of the second unit.  If you have 
the third unit, connect the <SYNCHRO OUT> connector of the second unit to the <SYNCHRO IN> connector of the third unit.  
Then connect another unit accordingly.  

 

2. In case of the IEEE1394 interface models, use the IEEE1394 cables to connect among the units in daisy 

chain.  Connect the PC installed the LX Navi to one of the units.  

 

In case of the Ethernet interface models, use a switching hub to connect the units and the PC installed the LX 

Navi.  

 

 

3. Turn ON the powers of the LX units and then the PC. 
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Operations 
You can set the master unit and the slave unit(s) by using the LX Navi. 

 

1. When starting LxNavi from a PC, the serial number information of the LX series units connected to the 

same segment is displayed on the LX selection dialog (LX Network). 

Click master, slave 1, slave 2…etc in the order of the “sync select” column. Setting information will be 

displayed for the area clicked upon.(Setting this operation once skips this process next time.) 

Click the “Sync Check” button. As a result, verification of specified LX synchronized operation settings and a 

verification test of the settings and the synchronized connection are done.  

In the example diagram below, 2 LX Series units are connected to the same group, and the serial number 

107100 for the master and 107366 for slave 1 have been selected (Click master and slave 1 in the order you 

wish to set them, in the “sync select” column). In this state, clicking the “Sync Check” button performs 

verification of synchronization mode settings and the synchronized connection. 
 

 
 

Explanation of the LX selection dialog (LX Network) columns.  

"Serial" Displays the serial numbers of the LX series recorder connected to the same segment. 

"use" Displays “ON” if in use and “OFF” if not in use. 

"ip address" Displays IP addresses. 

"name" Displays names set in LX.(Model IEEE1394 is an unchanging name) 

"status" Displays the results of verification tests for the connection status and synchronization 

connection. 

"Sync mode" Displays the synchronization settings of the LX main unit 

"sync select" Displays the set (linked) order of the master unit and slave unit for synchronized 

operations. 
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Explanation of names displayed immediately after launching the program or after “Update List” has been 

performed. 

 

After Initial display & "Update 

List” are performed 

Check BOX display 

status 

“Status” display “sync mode” 

display 

Executable unit  

(previously executed unit) 

Check mark present 

  

  

Non-executable unit No check mark present     

Unit in use 

(non-executable) 

Red check mark present

(Grey background) 

USE   

Unit of outside IP address outside 

(non-executable) 

No check mark present

(Grey background) 

IP ERR   

 

 

2. The dialog in the diagram below is displayed when "Sync Check is clicked upon. A check mark is displayed 

for the unit set to the master unit and a check mark with a grey background is displayed for the unit set to the 

slave unit. Confirm the verification test results for the synchronized connection and that a check mark is 

displayed in the check box, and click "OK".  

 

The diagram below shows that the serial number 107100 for master and 107366 for slave 1 have been set, 

that the synchronized connection verification is indicated properly (under “status”, CHECK is displayed for 

the master unit, and OK is displayed for the slave unit), and that a check mark is automatically displayed in 

the check box next to the serial number.(The check box for the slave unit is grey) Clicking the “OK” button in 

this state will launch LxNavi, which controls the master unit. 
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Explanation of names after executing “sync check” 

 

After executing “Sync Check” Check box display 

status “Status” display

Sync mode display 

The set master unit of 

synchronization operations  

Check mark present

CHECK 

MASTER 

The set master unit of 

synchronization operations  

 (connection result OK) 

Check mark present

(grey background)

OK SLAVE n 

 (n is the slave number) 

The set master unit of 

synchronization operations  

 (connection result NG) 

No check mark 

present 

NG SLAVE n 

 (n is the slave number) 

Set stand-alone unit  No check mark 

present  

NO SYNC 

Non-responsive unit model for 

synchronization operations 

No check mark 

present  

NOT SUPPORT 

Unit in which a 

communications error has 

occurred 

Red check mark 

present 

(grey background)

ERROR 

  

Unit in use Red check mark 

present 

(grey background)

(USE) 

  

Unit outside IP address group No check mark 

present 

(grey background)

(IP ERR) 

  

 

A “+” mark will be displayed in front of modified settings under “sync mode”.   

“Unit in use” and “units outside IP address group” will not be a target of “sync check”. 
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3. The main LX Navi screen of the master unit is displayed. In the bottom left of the screen under Target 

Unit the “M/name or serial number” is displayed. This main screen indicates the master unit. Moreover, the 

slave unit connected to the master unit is show below in “S*/ name or serial number”. 

In order to launch the LX Navi display screen of the next set slave unit, minimize the main display screen of 

the displayed master unit. 
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4. When LX Navi is re-launched from a PC, the LX selection dialog (LX Network) indicated in step 1 is displayed. 

In order to launch the LX Navi display screen set to the slave unit, click the box in the <serial> field of LX main 

unit set to the slave unit and click [OK]. (If the background of the check box is grey, click on it twice, confirm 

that a normal check mark is displayed and click [OK]. 

The main LX Navi display screen of the selected slave unit will now be shown. In the bottom left of the screen 

under Target Unit the “S*/name or serial number” is displayed. This main screen indicates the slave unit.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Open the main display for other slave units connected in the same manner. While maximizing or minimizing the 

main display screen of the master unit and each slave unit, set each recording condition of the LX main unit. 
 

 
5. If all LX main unit settings of synchronized recording end, close the main screen of all slave units, except for 

the main screens of the master unit and slave units that require monitoring while recording.  

Recording can be started and finished by operating the main window of the master unit. 

 

 

 

6. Close LxNavi in the opposite order to which it was started (slave n...., slave 1, master).   
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Miscellaneous  
 As LxNavi stores previously executed LX main unit serial numbers, if a previously used LX main unit is 

connected to an identical segment, a check mark will be present upon start-up, making execution possible 

with a simple click on [OK]. 

 

 Since the synchronization settings of the LX main unit are stored after being set only once, the next time 

the “Sync Check” button is clicked, synchronized connection verification all that is necessary. (Settings for 

the master and slave selection only have to be done once.) 

 

 If the LX main unit of the performed synchronization settings is used as an independent unit (mode in 

which normal synchronization operations are not done), clicking on the LX clock “sync select” cell (“NO 

SYNC” is displayed) will execute “sync check”. If this operation is performed once, the settings will be 

stored in the main unit, and normal start-up methods are all that is necessary next time.  
 

 
 

The diagram above shows the state after right clicking on the “sync select” column; where synchronized 
operation serial number 107100 has been reverted back to independent unit settings. Click the “Sync Check” 
button while in this state. 
 
 
 
 
 
 
 
 

 While the LX selection dialog (LX Network) is displayed, clicking on the “sync check” button will display the 

results of the synchronization connection verification under “Status”. “CHECK" will be displayed for the 

master unit which executed synchronization connection verification, and “OK” will be displayed for a 

verified slave unit connection.  If “NG” is displayed for the slave unit, make sure that the synchronization 

connection cable is correctly connected, press the “sync check" again, and execute synchronization 

connection verification. 

 

 If you wish to check the LX connected to the same segment again after the LX selection dialog (LX 

Network) has been displayed, click the “Update List” button. (If the LX power is turned on after launching 

LxNavi, etc)  

 

 

If the LX main unit of the performed synchronization settings is used as an independent unit 
without changing to stand-alone mode,  
LX may get unstable. 
Change LX to "NO SYNC" before LX is used as stand-alone mode. 
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Main Unit Specifications 
Recording Media    MO disk and memory, PC card and memory, or memory 

Capacity of MO Disk   1.3 GB 

Capacity of Memory   64 MB, up to 512 MB memory can be added as optional 

Amp Slot      2 in the main unit 

Interface      IEEE 1394-1995 compatible (LX-10/20) 

       100BASE-TX (LX-10L/20L) 

Sampling frequency   (Value in brackets is the recording bandwidth with tolerances of +/-0.5 dB) 

LX-10/10L        

96-1.5 kHz 96 kHz 

(DC-40 kHz) 

48 kHz 

(DC-20 kHz)

24 kHz 

(DC-10 kHz)

12 kHz 

(DC-5 kHz)

6 kHz 

(DC-2.5 kHz)

3 kHz 

(DC-1.25 kHz) 

1.5 kHz 

(DC-625 Hz)

        

LX-20/20L        

96-1.5 kHz 96 kHz 

(DC-40 kHz) 

48 kHz 

(DC-20 kHz)

24 kHz 

(DC-10 kHz)

12 kHz 

(DC-5 kHz)

6 kHz 

(DC-2.5 kHz)

3 kHz 

(DC-1.25 kHz) 

1.5 kHz 

(DC-625 Hz)

100-1 kHz 100 kHz 50 kHz 20 kHz 10 kHz 5 kHz 2 kHz 1 kHz 

65.536-1.024 kHz 65.536 kHz 32.768 kHz 16.384 kHz 8.192 kHz 4.096 kHz 2.048 kHz 1.024 kHz 

102.4-1.28 kHz 102.4 kHz 51.2 kHz 25.6 kHz 12.8 kHz 5.12 kHz 2.56 kHz 1.28 kHz 

Voice Memo     Sampling frequency: 8 kHz, WAV file 

Internal Clock Precision  +/-1 ppm (at 25 degree C) 

Operating Temperatures  5 to 35 degree C (MO model)  0 to 45 degree C (PC card model) 

Storage Temperatures    -20 to 60 degree C 

Operating Humidity    10 to 85% (no condensation) 

Storage Humidity    5 to 90% (no condensation) 

Power      +11 to 30 V DC  Use AC adaptor for AC source. 

Power Consumption   Approx. 35 W  (LX-10, AR-LXDC and AR-LXAO) 

External Dimensions   300W x 65H x 200D (mm) excluding protrusions 

Mass      Approx. 3.8 kg 
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Block Diagram 
LX-10/10L 8-channel input, 8-channel output 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Input Amp 

Output Amp 

Microphone Amp
Speaker Amp 

Front Panel 
I/F 

SCSI I/F

SDRAM 

SRAM 

ROM 

CPU 

Front Keys

Front LEDs

Drive (MO 
or PC Card) 

 
 
 
 
 
 
 
BUS 

I/F (IEEE1394 
or 
1000BASE-TX)

PLD 
(Clock/Decode) 

External 
Trigger Circuit

Monitor D/A

Remote 
Control I/F 

PC 

Input 

Output 

DIGITALCONTROL

MON OUT

External Trigger

MEMO IN 
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Tachometer Pulse Input Specifications 
You can use the tachometer pulse inputs to the PULSE IN A/B connectors of the LX-20/20L. 

Number of Inputs   16 bits mode: 2 channels     32 bits mode: 1 channel or 2 channels 

Input Method    Threshold Level + 0.5 V, + 1 V, + 2.5 V, + 5 V, + 10 V, + 20 V selectable 

      (Maximum input voltage +/- 50 V) 

      (Applicable input frequency 450 kHz) 

Input Impedance   100 kohm 

Measurement Mode  (1) pulse (gate): Pulse count mode within the gate time. 

       Range:  1 to 255 times of the sampling frequency. 

       Accuracy: +/- 2 counts 

      (2) pulse (total): Total counts from measurement start to stop 

       Accuracy:  +/- ± 5 counts 

      (3) period: Cycle count mode 

       Range: 1 msec, 5 msec, 10 msec, 50 msec, 100 msec, 500 msec, 1 sec 

       Accuracy: +/- 0.3 % (at 16 bits mode)   +/- 0.2 % (at 32 bots mode) 

      (4) frequency: Frequency measurement mode 

       Range: 10 Hz, 20 Hz, 50 Hz, 100 Hz, 200 Hz, 500Hz, 1 kHz, 10 kHz, 20 kHz 

       Accuracy: +/- 0.3 % (at 16 bits mode)   +/- 0.2 % (at 32 bits mode) 

      (5) rpm: RPM mode 

       Range: 1500 rpm, 3000 rpm, 6000 rpm, 9000 rpm,  

         12000 rpm, 18000 rpm, 24000 rpm 

       Accuracy: +/- 0.3 % (at 16 bits mode)   +/- 0.2 % (at 32 bits mode) 

       Divided Rate: 1 to 255 

       Moving Average:  1 to 16 

       Number of Pulse per Revolution: 1 to 255 

       Tachometer Pulse Timing:  Use LSB 1 bit for the tachometer pulse timing  

        Note that this function is available at the sampling frequency 48 kHz or lower. 

 

 1 x 16 bits tachometer pulse input channel is equivalent to 1 x analog input channel.  1 x 32 bits 

tachometer pulse input channel is equivalent to 2 x analog input channels.  Therefore, if you turn ON 

tachometer pulse input channel(s), in order keep the same analog input channels, lower the sampling 

frequency is required by following the setting of tachometer pulse input channel(s).  

 Set Moving Average to [1] only, when the sampling frequency of 102.4 kHz, 100 kHz, 96 kHz, 65.536 kHz, 

51.2 kHz, 50 kHz, 48 kHz, or 32.768 kHz is selected.  

 Only 1 x 32 bits tachometer pulse input can be selected when the sampling frequency of 102.4 kHz, 100 

kHz, 96 kHz, or 65.536 kHz is selected.  

 The LX Navi cannot monitor the tachometer pulse input in wave form display.  Use the distal display to 

monitor. 

 The LX cannot playback the recorded tachometer pulse input signals.  Process the data as digital data file. 

 You cannot use the tachometer pulse inputs and the generator output function at the time. 

 

 

 

 



Generator Output Specifications 

6-6 

Generator Output Specifications 
You can use the MON OUT connector of the LX-20/20L for the generator output. 

Number of Output Channel   1 channel 

Output Level      1 to 5 V at 0.1 V steps (same as the monitor output) 

Output Connector     MON OUT (Monitor output) BNC 

Types of Outputs     SIN, SWEEP SIN, Pulse, Pink noise, White noise 

Noise Level      -70 dB or less (at SIN output) 

 

 You cannot use the tachometer pulse inputs and the generator output function at the time. 
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Expansion Unit Specifications 
<AU-LXEPIO> 
Expansion Unit for DC Amp 
Amp Slot     2 slots 
Dimensions    300W × 30H × 200D (mm) (excluding protrusions) 
Mass     Approximately 1.2 kg 
 
<AU-LXEPIOP> 
Expansion Unit for PA Amp/ST Amp 
Amp Slot     2 slots 
Power Supply    +11 to 30 V DC   comes with AC adaptor 
Dimensions    300W × 50H × 200D (mm) (excluding protrusions) 
Mass     Approximately 2 kg 
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External Dimensions 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

300 mm

300 mm

200 mm 

200 mm 

30 mm 

50 mm 

LX Main Unit + AU-LXEPIO

LX Main Unit + AU-LXEPIOP
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DC Input Amp Specifications 
<AR-LXDC> 
Quantization Bits   16 bits (simultaneous sampling, use MSB16 bits of 24 bits ADC) 
Conversion Method  128 times over-sampling delta-sigma method, 64 times at 96 kHz sampling 
Num. of Input Channels 8 channels 
Input Range    +/-0.5, 1, 2, 5, 10, 20, 50 Vp (Exceeded range +/-120%) 
Absolute Max. Input Voltage +/-100 V 
Input Impedance   100 k ohm unbalanced 
Filter     Joint use of digital and analog filters 
Linearity     +/-0.1% or less 
Distortion    +/-0.05% or less (at bandwidth of 20 kHz) 
Drift      +/-0.1% or less 
Dynamic Range   80 dB (within bandwidth) 
S/N Ratio    78 dB (within bandwidth) 
Cross-talk    78 dB (within bandwidth, 48 kHz or lower sampling) 
      75 dB (within bandwidth, 96 kHz sampling) 
Inter-channel Phase Difference  1 degree or less (in same range with bandwidth 20 kHz or less) 
        3 degrees or less (in same range with bandwidth 40 kHz) 
 
<AR-LXDC2>  
Addition to the specifications of the AR-LXDC, Low-speed sampling mode (1 kHz to 1/60 Hz) is available. 
Conversion Method  128 times over-sampling delta-sigma method, 2 kHz sampling 
Sampling Frequency  1 kHz, 500 Hz, 200 Hz, 100 Hz, 50 Hz, 20 Hz, 10 Hz, 5 Hz, 2 Hz, 1 Hz, 1/2 Hz, 
      1/5 Hz, 1/10 Hz, 1/30 Hz, 1/60 Hz 
      (down sampling of 2 kHz sampling data by using DSP) 
Recoding Times   Example to use 1.3GB MO in 8 channels’ recording 
      100 Hz sampling,  
      Memo off: Approximately 200 hours   Memo on: Approximately 33 hours 
      1 Hz sampling, 
      Memo off: Approximately 20000 hours   Memo on: Approximately 40 hours 
Digital Filter Characteristics  Caused aliasing at 100 Hz or lower 

Sampling Frequency (Fs) Cut-off Frequency (Fc) Attenuation 

1 kHz 400 Hz - 80dB (at 500 Hz) 

500 Hz 200 Hz - 80dB (at 250 Hz) 

200 Hz 80 Hz - 80dB (at 100 Hz) 

100 Hz 80 Hz - 80dB (at 100 Hz) 

50 Hz, 20 Hz 10 Hz, 
5 Hz, 2 Hz, 1 Hz 

40 Hz - 80 dB (at 50 Hz) 

1/2 Hz, 1/5 Hz, 1/10 Hz, 
1/30 Hz, 1/60 Hz 

20 Hz - 80dB (at 25 Hz) 
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Filter Characteristics 
The analog filter is a 2nd-order Butterworth filter, with a cutoff frequency that is about 1.2 times the aliasing 

frequency (1/2Fs).  The filter prevents 128-times delta-sigma A/D (analog to digital) high-order aliasing. 

The digital filter is used when down-sampling 128-times delta-sigma A/D data.  The attenuation 

characteristics are about -6 dB at 1/2Fs.  The aliasing component in -6 dB occurs at a sampling frequency of 

1.1 times from 1 of the 1/2Fs.  The attenuation is abrupt so attenuation occurs quickly up to the noise level. 

 

 

 

 

 

 

 

 

Calibration 
When the power is turned on, all channels and all ranges self-calibrate using a DSP.  In this operation, when 

the power is first turned on, the 2 basic signals of zero and + full scale are converted from analog to digital, 

and the zero point error and gain error are calculated for each range, and then stored.  During recording, 

the data converted from analog to digital is adjusted by the calibration data for each range.  

 

Block Diagram 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

-6 dB 

Analog filter 
(-12 dB/oct) 

1/2 Fs 

Digital filter 

1.1 x 1/2 Fs 

Input Amp A/D

 
 
PLD 

FIFO DSP FIFO 

RAM 

Input Amp A/D

 

IN 1 

IN 8 
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PA Amp Specifications 
<AR-LXPA1> 
Num. of Channels   8 
Input Format    Balanced and unbalanced 
Input Coupling   Balanced AC coupling, balanced DC coupling, unbalanced DC coupling 
Input Impedance   150 k ohm 
Input Range    +/-0.01 V, 0.0316 V, 0.1 V, 0.316 V, 1 V, 3.16 V, 10 V (over range +/-127%) 
Absolute Max. Input Voltage +/-50 V 
Filter     Joint use of digital filter and analog filter 
Frequency Response  Flatness: +/-0.5 dB 
 In AC mode   1 Hz to each bandwidth of the LX main unit. 
 In DC mode   DC to each bandwidth of the LX main unit. 
Quantization Bits   16 bits (simultaneous sampling, use MSB16 bits of 24 bits ADC) 
Conversion Method  128-times over-sampling delta sigma modulation.  

at 96 kHz sampling, 64-times over-sampling is used. 
Sampling Frequency  Depends on the sampling frequency of the LX main unit. 
Range Precision   +/-2% or less 
Linearity     +/-0.1% or less 
Distortion Factor   At 48 kHz or 96 kHz sampling: 
      When the input range is 0.316 V or more: +/-0.05% or less. 
      When the input range is 0.1 V or less: +/-0.2% or less. 
      At sampling of 24 kHz or less, +/-0.4% or less. 
Drift      +/-0.1% or less  
      (10 or more minutes after power is turned on, at an input range of 1.0 V) 
S/N and Crosstalk 

 S/N  Crosstalk  

Input Range 
Within Bandwidth 

20 kHz or less 
Within Bandwidth 

40 kHz or less 
Within Bandwidth 

20 kHz or less 
Within Bandwidth 

40 kHz or less 

+/- 0.01 V 64 dB 60 dB －64 dB －60 dB 

+/- 0.0316 V 74 dB 69 dB －71 dB －69 dB 

+/- 0.1 V 83 dB 76 dB －77 dB －73 dB 

+/- 0.316 V 87 dB 77 dB －77 dB －73 dB 

+/- 1.0 V 87 dB 77 dB －77 dB －73 dB 

+/- 3.16 V 87 dB 77 dB －77 dB －73 dB 

+/- 10 V 87 dB 77 dB －77 dB －73 dB 

Inter-channel phase Difference  1 degree or less (with same range and a bandwidth of 20 kHz or less) 
        3 degrees or less (with same range and a bandwidth of 40 kHz) 
Power to Sensor   28 V DC, 4 mA 
TEDS     Read TEDS information at the LX Navi or the color LCD remote control unit 
Power Consumption  Approx. 7 W 
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<AR-LXPA3>  
Addition to the specifications of the AR-LXPA, +/- 50 V input range and A/C/FLAT filter are available. 
Input Impedance   470 kohm or more (+/-0.01 to 3.16 V)   100 kohm (+/- 10 V, +/- 50 V) 
Input Range    ±0.01 V, 0.0316 V, 0.1 V, 0.316 V, 1 V, 3.16 V, 10 V, 50 V (Over range +/-127 %) 
Absolute max. Input Voltage +/- 50 V (±0.01 to 3.16 V)   +/- 100 V (+/-10 V, +/- 50 V) 
HPF      3rd order butterworth filter  10 Hz (+/- 0.5 dB or less), 20 Hz (+/- 0.5 dB or less) 
Weighting    A curve, C curve, Flat  IEC-TYPE1 
Power to Sensor   28 V DC/4 mA, 24 V DC/4 mA (internal switch) 
S/N and Crosstalk 

 S/N  Crosstalk  

Input Range 
Within Bandwidth 

20 kHz or less 
Within Bandwidth 

40 kHz or less 
Within Bandwidth 

20 kHz or less 
Within Bandwidth 

40 kHz or less 

+/- 0.01 V 64 dB 60 dB - 64 dB -60 dB 
+/- 0.0316 V 74 dB 69 dB - 73 dB -69 dB 
+/- 0.1 V 83 dB 77 dB -78 dB -74 dB 
+/- 0.316 V 87 dB 77 dB -78 dB -74 dB 
+/- 1.0 V 87 dB 77 dB -78 dB -74 dB 
+/- 3.16 V 87 dB 77 dB -78 dB -74 dB 

+/- 10 V 87 dB 77 dB -78 dB -74 dB 

+/- 50 V 80 dB 77 dB -78 dB -74 dB 
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ST Amp Specifications 
<AR-LXST1> 
Num. of Channels   8 
Input Format    Balanced differential 
Input Coupling   Balanced DC coupling, DC bridge method 
Input Impedance   1 Mohm 
Input Range    ST mode ±0.25 mV/V, 0.5 mV/V, 1 mV/V, 2.5 mV/V, 5 mV/V, 10 mV/V, 
               25 mV/V、50 mV/V (over range +/- 127%)  
      DC mode ±1 V, 2 V, 5 V, 10 V (over range +/-127%) 
Absolute Max. Input Voltage +/- 25 V 
Filter     Joint use of digital filter and analog filter 
LPF      10/30/100/300/1 k/3 k/10 k/30 kHz/Pass: - 48 dB OCT butterworth  
      (switched capacitor filter) 8 channels independently 
Frequency Response     
 In ST mode   DC to 30 kHz (-3 dB)  
 In DC mode   DC to 40 kHz (-3 dB) 
Quantization Bits   16 bits (simultaneous sampling, use MSB16 bits of 24 bits ADC) 
Conversion Method  128-times over-sampling delta sigma modulation.  

at 96 kHz sampling, 64-times over-sampling is used. 
Sampling Frequency  Depends on the sampling frequency of the LX main unit. 
Range Precision   +/-1% or less 
Linearity     ±0.1% or less 
Distortion Factor     
        
        
        
Applicable Gage Register 120 to 2000 ohm 
Gage Factor    2.0 
Bridge Voltage   2 V (±1 V) / 10 V (± 5V) 
Bridge Connection  Full bridge 
Remote Sense   Available 
Temperature Drift   ±0.1%/1 degree C(10 or more minutes after power is turned on) 
Balance Method   Electronic auto balance 
Balance Range   ±10000microST 
Zero Balance    Auto and manual calibration by using 16 bits D/A 
S/N and Crosstalk 
 

ST Mode SCF 

Bridge Voltage=2V 1 KHz 3 KHz 10 KHz 

 SNR(dB) Cross Talk(dB) SNR(dB) Cross Talk(dB) SNR(dB) Cross Talk(dB)

+/-0.5mＶ       

+/-1mV       

+/-2mV       

+/-5mV       

+/-10mV       

+/-20mV       

+/-50mV       

+/-100mV       

       

DC Mode SCF bypass      

Input Level 24 KHz or less   

       

 SNR(dB) Cross Talk(dB) SNR(dB) Cross Talk(dB) SNR(dB) Cross Talk(dB)

+/- 1V       

+/- 2V       

+/- 5V       

+/- 10V       
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Inter-channel phase Difference  1 degree or less (with same range and a bandwidth of 20 kHz or less) 
        3 degrees or less (with same range and a bandwidth of 40 kHz) 
Conenctor     Lemo 7-pin  10 ø (EGC0B Type) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Power Consumption   Approx. 8 W 
 
 
 
 
 
 
 
 
 
 
 
 
 

Signal IN + 

Signal IN - 

Remote Sense + S 

Remote Sense - S 

GND 

Bridge Voltage - VB 

Bridge Voltage + VB 
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Output Amp Specifications 
<AR-LXAO> 
Num. of Output Channels  8 
Output Voltage   +/-1 to 5 V (0.1 V steps) 
Impedance    75 ohm unbalanced 
Output Current   +/-1 mA (at 20 ohm load) 
Filter     Joint use of digital and analog filters 
Linearity     +/-0.1% or less 
Distortion    +/-0.05% or less (at bandwidth of 20 kHz) 
Drift      +/-0.1% or less 
Dynamic Range   80 dB (within bandwidth) 
S/N      78 dB (within bandwidth) 
Crosstalk     78 dB (within bandwidth, 48 kHz or lower sampling) 
      75 dB (within bandwidth, 96 kHz sampling) 
Inter-channel Phase Difference  1 degree or less (in same range with bandwidth 20 kHz or less) 
        3 degrees or less (in same range with bandwidth 40 kHz or less) 
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Filter Characteristics 
The analog filter is a 2nd-order Butterworth filter, with a cutoff frequency that is about 1.2 times the aliasing 

frequency (1/2Fs).  

The digital filter attenuation characteristics are about -6 dB at 1/2Fs. The input amp and output amp are 

both added for the input signal, so (as shown in the following diagram) the attenuation is about -12 dB at an 

aliasing frequency (1/2 Fs).  

 

 

 

 

 

 

 

 

 

 

Block Diagram 
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Analog filter 
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Digital filter 
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OUT 8 



File Format 

6-17 

. , : ; < > [ ] * ? = “ / ¥   ¦ 

. , : ; < > [ ] * ? = “ / ¥   ¦ 

File Format 
Type of Files 
The LX makes a binary-format data file and ASCII-format header file each time recording stops or pauses.  

Data file: Contains A/D data in binary format.  The file extension is dat. 

Header file: Contains recording conditions, etc., in text format.  The file extension is hdr. 

 

 The files are stored in DOS format on the media. 

 When a voice memo is recorded, a WAVE file is made in addition to the above.  You can play this WAVE 

file in the Windows Media Player. 

 

File Name 
The file name is common to the data file and header file.  An ID number is added to the end of the specified 

file name.  When you specify a new file name, the ID number starts from 1.  After recording is stopped or 

paused, the ID number is automatically incremented each time the recording restarts.  If a data file with the 

same name or same ID number already exists when recording to the media or PC, the next ID number is used.  

 

 When Recording to Memory or to the media 

To specify a file name, choose File and New, and then specify the file name in Dataset.  For the file name, use 

up to 5 alphanumeric characters.  You cannot use the following characters: 

 

 

The system attaches a 3-digit ID number (starting from 001) to these 5 characters to make a total of 8 

characters.  If you specify 4 or fewer characters, the system changes the total number of characters to 8 by 

using a 0 before the 3-digit ID number to pad each of the missing locations. 

 

 When Recording to a PC 

When recording to a PC, or when recording to a PC while recording to memory or the media, there is no 

restriction on the length of the file name.  You cannot use the following characters: 

 

 

 

An ID number of up to 8 characters can be added to that file name. 
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Directory Structure on Media 
The following diagram shows how directories are organized on the media:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. TEAC_LX 

This directory is made automatically when the media is formatted.  When the media is inserted in an LX, 

this directory is made automatically if it does not already exist.  

 

2. TEST0001 

Name of the directory entered in Directory, which is in the dialog box displayed by choosing File and then 
New. 

 

3. Aaaaa001.dat、Aaaaa001.hdr、 Aaaaa001.wav 

The data file, header file, and voice-memo file (if a voice memo was recorded) generated for each ID.  

 

 

Root 

TEAC_LX 
TEST0001 

Aaaaa001.dat
Aaaaa001.hdr
(Aaaaa001.wav)

Aaaaa002.dat
Aaaaa002.hdr
(Aaaaa002.wav)

TEST0002 
Bbbbb001.dat
Bbbbb001.hdr

1
2

3
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Data File 
Data converted from analog to digital is recorded as 2-byte integers from -32768 to +32767.  Negative 

numbers are expressed as complements of 2. 

 

The byte order is from the lower bytes to the higher bytes (Intel format)*1.  

 

The order of data is as follows: first sampling channel order, second sampling channel order, ....., last sampling 

channel order. This order is called the INTERLACED format*2, and the format name is recorded in 

STORAGE_MODE in the header file. 

The organization of a data file is shown in the following diagram.  In this document a collection of data as 

shown in the example is called one scan.  A data file consists of scan repetitions. 

 

Example 
Data of 1 scan when recorded with a sampling frequency of 6 kHz: 

 

 

 

 

 

 

 

 

 

 

Notes 
*1. The byte order from the higher to the lower bytes is called the Motorola format. It is used in components 

such as FFT analyzers that used Motorola CPUs and in workstations. 

 

*2. The order of data of the SEQUENTIAL format is as follows: first channel sampling order, second channel 

sampling order, ....., last channel sampling order. 

 

 

 

 

 

 

ch 1 
ch 2 
ch 3 
ch 4 
ch 5 
ch 6 
ch 7 
ch 8 

Data Sequence 

1/6000 seconds
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Data File When Turning on Tachometer Pulse Inputs 
The LX-20/20L can record the tachometer pulse input channel(s) assigned at either one of the following 4 

tachometer pulse inputs modes along with analog channels.  

 

2 x 16 bits tachometer input channels (Tachometer pulse input channel A and B) 

1 x 32 bits tachometer input channel (Tachometer pulse input channel A) 

1 x 32 bits tachometer input channel (Tachometer pulse input channel B) 

2 x 32 bits tachometer input channels (Tachometer pulse input channel A and B) 

 

25,000 is 100% range value at 16 bits mode. 

1,638,400,000 is 100% range value at 32 bits mode. 

 

The LX-20/20L records the tachometer pulse input data by reflecting the number of pulses per revolution 

and /or the pre-set divided rate.  

 

The tachometer pulse input data are recorded at the next to the last analog channel of each scans.  See the 

following. 
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Example 
8 analog channels, and 2 x 16 bits tachometer pulse input mode: 
(Keyword on the header file for the tachometer pulse input channels are PULSE_CH_A 9 and PULSE_CH_B_10.) 
 
1 scan 

Channel 1 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 2 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 3 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 4 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 5 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 6 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 7 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 8 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Tachometer Pulse Input 
Bit7.............................Bit0 

Channel A 
Bit15............................Bit8

  

Tachometer Pulse Input 
Bit7.............................Bit0 

Channel B 
Bit15............................Bit8

  

 
 
8 analog channels, and 2 x 32 bits tachometer pulse input mode: 
(Keyword on the header file for the tachometer pulse input channels are PULSE_CH_A 9 and PULSE_CH_B_10.) 
 
1 scan 

Channel 1 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 2 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 3 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 4 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 5 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 6 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 7 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 8 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Tachometer Pulse Input 
Bit7..............................Bit0 

Channel A 
Bit15............................Bit8

 
Bit23..........................Bit16 

 
Bit31..........................Bit24

Tachometer Pulse Input 
Bit7..............................Bit0 

Channel B 
Bit15............................Bit8

 
Bit23..........................Bit16 

 
Bit31..........................Bit24
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Converting Data to Physical Quantities 
Data converted from analog to digital is 2-byte integers from -32768 to +32767.  

When the input is +/-100% of the set input range, the value is +/-25000.  

The input value is obtained from the following formula: 

Input value =  (A/D conversion value of the data file) x SLOPE + Y_OFFSET 

 

 About the tachometer pulse input data 

25,000 is 100% range value at 16 bits mode. 

1,638,400,000 is 100% range value at 32 bits mode. 

 

The LX-20/20L records the tachometer pulse input data by reflecting the number of pulses per revolution 

and /or the pre-set divided rate.  
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Header File 
Header files are ASCII-format text files containing information such as recording conditions.  Header files are 

based on the waveform-analysis software DADiSP format.  Because the files are in text format, they can be 

read by Windows applications such as WordPad or NotePad. 

In a header file, each recording-condition entry is written on 1 line, with parameters separated by a comma (,). 

The following shows an example of a header file, with the entries explained after the file. 

 
 Example of Header File (LX-10/10L) 

DATASET TEST0001 
VERSION 1 
SERIES CH1_LX10_DC100K,CH2_LX10_DC100K,CH3_LX10_DC100K,CH4_LX10_DC100K, 
CH5_LX10_DC100K,CH6_LX10_DC100K,CH7_LX10_DC100K,CH8_LX10_DC100K  
DATE 06-23-2001 
TIME 16:32:55.00 
RATE 1500 
VERT_UNITS V,V,V,V,V,V,V,V  
HORZ_UNITS Sec 
COMMENT <LX-10> 
NUM_SERIES 8 
STORAGE_MODE INTERLACED 
FILE_TYPE INTEGER 
SLOPE 0.00008000,0.00008000,0.00008000,0.00008000,0.00008000,0.00008000,0.00008000,0.00008000  
X_OFFSET -5 
Y_OFFSET 0,0,0,0,0,0,0,0  
NUM_SAMPS 59200 
DATA 
DEVICE LX-10 
SLOT1_AMP AD_AMP,8,00000006, 
SLOT2_AMP DA_AMP,8,00000006, 
CH1_1 LX10_DC100K,RANGE=2V,FILTER=ON 
CH2_2 LX10_DC100K,RANGE=2V,FILTER=ON 
CH3_3 LX10_DC100K,RANGE=2V,FILTER=ON 
CH4_4 LX10_DC100K,RANGE=2V,FILTER=ON 
CH5_5 LX10_DC100K,RANGE=2V,FILTER=ON 
CH6_6 LX10_DC100K,RANGE=2V,FILTER=ON 
CH7_7 LX10_DC100K,RANGE=2V,FILTER=ON 
CH8_8 LX10_DC100K,RANGE=2V,FILTER=ON 
ID_NO 1 
TIME 20010623163255,20010623163335 
REC_MODE MO 
START_TRIGGER COMMAND,PRE 
STOP_CONDITION COMMAND,POST 
START_PRE_COUNT 7500 
STOP_POST_COUNT 15000 
MARK 100,200,300 
ID_END 
VOICE_MEMO 8BITS,327680 
LX10_VERSION PAL1_VER,PAL2_VER,V0.03,02200000 
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 Explanations of Header File 
DATASET   File name 
VERSION   1 (This is a fixed value.) 
SERIES   Number of the channel used for recording.  The channel name is after the underscore. 
DATE   Date when recording started (month-day-year) 
TIME   Time when recording started (hour: minute: second) 
RATE   Sampling frequency (Unit: Hz) 
VERT_UNITS  Physical/engineering units of each channel 
HORZ_UNITS  Time axis units (Sec: This is a fixed value) 
COMMENT  Comment entered using File and New. 
NUM_SERIES  Number of recording channels 
STORAGE_MODE Data order.  Fixed as INTERLACED because this is the scan order. 
FILE_TYPE  Fixed as INTEGER because this is a 2-byte integer for 1 data item. 
SLOPE   Coefficient used when converting data to physical/engineering units 
X_OFFSET  Location of the beginning data on the time axis. Usually is 0.   

The set value (in seconds) is written using 
    minus for the pre-trigger time.  Even if you set the number of scans for Pre-trigger, this will be in 
    seconds. (Values below the decimal point are discarded.) 
Y_OFFSET  Offset used for converting data to physical/engineering units. 
NUM_SAMPS  Number of data items recorded per channel 
DATA   The information written after this entry is proprietary to this device, and indicates information different 
    from the DADiSP format.  The information below is not recorded when recording to a PC. Also, it is not 
    recorded in the header file on the PC when recording to a PC while recording to memory or the media. 
DEVICE   LX-10/LX-20 (This is a fixed value.) 
 
(The information below is not recorded when recording to a PC.) 
 
SLOT1_AMP  The ID-name, number of channels, and versions of the amp in slot 1, next to SLOT2_AMP.Depending  

on the system conguration. 
CH1_   The following information is written after the underscore: channel number, amp type, range setting,  
    filter setting. (This is always ON for a DC amp.) 
ID_NO   ID number 
TIME   Recording start date and time, recording stop date and time (YYYYMMDDhhmmss) 
REC_MODE  Recording destination device (MEMORY, MO, PC CARD, PC) 
START_TRIGGER Recording start conditions: COMMAND: Interface command 
          PANEL: FWD button of the front panel 
          LEVEL: Level trigger 
          DATE: When Repeat Count is 1 in the interval action 
          TIMER: When Repeat Count is 2 or more in the interval action 
          EXT: External trigger 
          TIME_OUT: Timeout 
          ,PRE: Added for a pre-trigger 
STOP_CONDITION Recording stop conditions: COMMAND: Interface command 
          PANEL: STOP button of the front panel 
          LEVEL: Level trigger 
          TIMER: Specified recording time 
          EXT: External trigger 
          MEMORY_FULL: Memory is full 
          MEDIA_FULL: Media is full 
          POST: Added for a post-trigger 
START_PRE_COUNT  Number of scans recorded by a pre-trigger 
STOP_POST_COUNT Number of scans recorded by a post-trigger 
MARK   Number of scans at the instant an event mark was attached. 
ID_END   The following information applies to the LX hardware, etc. 
VOICE_MEMO  The number of bits per sample for voice-memo data.  Data size (bytes) 
LX10_VERSION Firmware and PAL version of the LX-10 
(LX20_VERSION) for LX-20 
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 The LX-20/20L attaches the following information after DEVICE. 
When the tachometer pulse input channel is set 
PULSE_CH_A  Tachometer pulse input channel number, 9 for the LX has 8 analog inputs. 
PULSE_MODE_A Tachometer pulse input mode, number of bits, measurement mode number, range setting 
     Measurement Mode  0: Pulse counter mode, gate 
          1: Pulse counter mode, total 
          2: Cycle count mode 
          3: Frequency mode 
          4: RPM mode 
PULSE_LEVEL_A Threshold level 
DIVIDE_RATE_A Divided rate 
MOVE_AVERAGE_A Moving average 
PULSE_PER_1R_A Number of pulse per revolution 
 
The LX-20/20L may not generate some of above information depending on the selected measurement mode. 
 
When the tachometer pulse input channel B is assigned, the information above will be changed to B from A.  
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Connector Specifications 
DIGITAL CONTROL Connector 
<Functions> 
Contact input: REC FWD, REC, FWD, STOP, PAUSE, event, panel lock, internal clock adjustment 
Status output: REC, FWD, STOP, PAUSE, event, panel lock 
 
<Input/Output Circuit> 
Input: L level: 0.4 V or less 
 H level: Open or 2 V or more 
 Pulse width: 100 ms or more 
Output: Open drain, maximum sync current: 8 mA 
 
<Connector> 
Angled half pitch 36-pin (DHA-RC36-R1xxx series) 
 
Pin Assignment 

Pin No. Signal Function Pin No. Signal Function 

1 GND Ground 19 GND Ground 

2 RESERVED Reserved 20 RESERVED Reserved 

3 RESERVED Reserved 21 RESERVED Reserved 

4 GND Ground 22 AGND Reserved 

5 RESERVED Reserved 23 AGND Reserved 

6 RESERVED Reserved 24 AGND Reserved 

7 GND Ground 25 AGND Reserved 

8 RESERVED Reserved 26 RESERVED Reserved 

9 RESERVED Reserved 27 RESERVED Reserved 

10 RTCADJIN Internal clock 
adjustment input 

28 NC  

11 RECFWDIN REC FWD input 29 NC  

12 RECIN REC input 30 RECSTS REC output 

13 FWDIN FWD input 31 FWDSTS FWD output 

14 STOPIN STOP input 32 STOPSTS STOP output 

15 PAUSEIN PAUSE input 33 PAUSESTS PAUSE output 

16 EVENTIN EVENT input 34 EVENTSTS Event output 

17 PLOCKIN Panel Lock input 35 PLOCKSTS Panel Lock output 

18 GND Ground 36 GND Ground 

 

For PANEL LOCK input, the control buttons on the front panel of the LX cannot be used to perform operations. 
The first signal locks the control buttons; the second signal releases the lock.  
 
 
 
 
 
 
 

 

 

 

100ms or more

Lock Release 

1s or more 
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Recording Synchronization Specifications 
Number of Units to be Synchronized  4 
Inter-channel Phase Differences  Channels with the different units 
         5 degree or less (with same range and a bandwidth of 20 kHz or less) 
         7 degree or less (with same range and a bandwidth of 40 kHz) 
Total Synchronization Cable Length  Within 10 m 
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Troubleshooting 
If you encounter one of the following problems, check whether the recommended actions solve the problem 
before you request a repair.  
 

Problem Possible cause and recommended action 
No power.  Check whether the DC voltage is low.  
The LX Navi software does not 
recognize the LX. 

Make sure that the IEEE 1394 interface card is one of the 
recommended cards. 
Make sure that both the LX and the PC have matched IP 
addresses. 
Power on the LX again, and then restart LX Navi.  

The MO disk is not recognized in the 
New dialog box. 

Make sure the media is formatted. 
Make sure you are using the specified media. 

You cannot record to the media. Make sure that the media is inserted. 
Make sure that the media is formatted. 
Make sure that the MO disk is not write-protected.  

The Auto Saving function for 
automatically saving to the media is not 
working. 

Make sure that the media is formatted. 
Make sure that the media is not full. 
Make sure that the Auto Saving option is selected.  Note 
that turning off the power will disable the Auto Saving 
option. You must enable it each time you turn the power 
on.  

The buttons on the main unit are 
disabled. 

Make sure that panel is not locked (P LOCK button).  If the 
panel is locked, release the lock. 

The eject button on the main unit is 
disabled at the MO model. 

Note that while LX Navi is running, the eject button on the 
LX MO drive is disabled.  

You cannot set the sampling frequency. Make sure that number of the channels you activate is 
larger than available number of the channels at the 
sampling frequency in case turning on the tachometer input 
channels. 

A write or read error occurred on the MO 
disk. 

Clean the MO disk and the lens. To clean the MO disk, use 
the cleaning kit TZ-381. 
To clean the lens, use the cleaner 0240470.  

 
If you perform the recommended action but the problem remains, contact TEAC's service department.  
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Supplied Accessories and Options 
Supplied Accessories 
DC Power Cable     1 

Microphone      1 

Earphone      1 

Ferrite Core      2 

CD-ROM (LX Navi)    1 

MO Disk       1(Only for the MO model) 

Instruction Manual (this manual) 1 

AC Adaptor      1 

 

 

Options 
MO Disk       T0005380 

MO Cleaning Kit     TZ-381 

Lens Cleaner      0240470 

Expansion Unit     AU-LXEPIO (for DC input amp) 

        AU-LXEPIOP (for PA amp and ST amp) 

Battery Enclosure     BU-80 

Battery Pack 
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Note 
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